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Main Topics 

 

 Main Topics 
 

This Help explains how to use Amicus Billing. It supplements the basic Amicus instructions 
provided in the Amicus Attorney User Help. 

Topic Description 

Welcome About this Help and What's New 

Getting Around Log into Amicus, and exit. Use the Amicus Navigation Pane, 
modules, and Billing Home screen. 

Setting Up Your Office Customize your Amicus Office (preference settings). 

Dailies Stay informed by viewing today's billing reminders and the Billing 
Manger. 

Files Manage activities related to your client matter files. 

Clients Manage details on the clients you work with. View, share and 
pay invoices in the Client Portal. 

Time, Fees, and Expenses Manage your billable and non-billable time spent and the client 
expenses accrued. 

Trust Manage your client trust funds. 

Billing View and create client file bills, enter bill payments, do bill write-
ups/downs, and generate reminder statements. 

Reports Run reports. Customize reports and templates. 

APX (Abacus Payment 
Exchange) 

A payment solution that uses a single platform to process Credit 
Card and ACH payments. 

Keyboard Shortcuts Use <CTRL> and Function keys to navigate and work more 
quickly. 

Third-Party Links Link with QuickBooks. 
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Welcome 
 

Welcome 
 

Welcome to Amicus Billing! 

Amicus Billing adds billing, collections, and trust capabilities to Amicus. It makes Amicus a 
complete practice management solution that manages both the professional and business side of 
your practice. 

Amicus Billing is a separately licensed component. If you would like to add this powerful billing 
solution to your Amicus Office, contact the Amicus Sales Office. 

About this Help 
This Billing User Help explains in detail how to use the many features of Amicus Billing. It 
supplements the basic Amicus instructions provided in the Amicus User Help. 

It is imperative that those who are designated as Administrators read the Amicus Billing 
Administrator Help for details of customizing Amicus Billing, and the Amicus Attorney 
Administrator Help for details on basic customization, managing users, importing information, and 
administering the database. 

Definitions 
• Billing User is a Firm Member who has access to the Billing modules and functions. 
• Billing Supervisor is a Billing User who has Billing access to all Billing modules and all Files 

and Clients. 
• Amicus Administrator has access to firm setup (both basic and Billing-related) and 

administrator functions and utilities. 

Document Conventions 
The following typographical conventions are used in the documentation: 

• Text that you should enter exactly as printed is shown in Courier font, e.g. 3/28/2022. 
• Keys that you press are shown in uppercase within angle brackets, e.g. <DELETE>. 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/BillingUserHelp/index.htm#t=Cover.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/BillingAdminHelp/index.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/BillingAdminHelp/index.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/AdminHelp/index.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/AdminHelp/index.htm
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Welcome > What's new 
 

What's new 
 

We are excited to announce the following enhancements in Amicus Billing: 

August 2022 

APX (Abacus Payment Exchange) Test Transaction 

Onboard to APX and receive a $5 gift to see for yourself how funds flow through the portal and 
into your bank account. 

APX Disbursement Report 

The new APX Disbursement Report comes directly from APX. It allows you to view funds that 
were collected from APX and disbursed into your bank account. You can select a Report Period 
and/or enter search criteria to filter the report. 

Expanded Email Settings for APX 

The new APX Email Settings options gives greater control  over how internal firm members are 
notified about APX transactions. Enable or disable specific notifications and adjust distribution 
lists so the right team members are kept informed. This could include failed payments, refunds, 
voids, recurring payments and more. 

Removing APX Payment Methods via the Client Portal 

A new Remove button allows clients to have greater self-serve options by being able to delete 
their own APX payment methods. A payment method cannot be deleted if it is tied to a recurring 
payment schedule. 

Removing APX Payment Methods via PayNow 

Clients who are sent a PayNow link allowing them to quickly pay their invoices can now manage 
their own saved payment methods. Payment methods that are tied to a recurring payment 
schedule cannot be deleted. 

Bills can now be exported to a single PDF 

Saving multiple draft bills to a single pdf file makes it easier to share multiple bills for review 
before they are finalized. This same capacity extends to finalized bills should you wish to save 
them as a single PDF. 

New features have been added to the Tutorial Office 

You can now use sample data provided in the Tutorial Office to create bills and run most reports. 
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February 2022 

Introducing Abacus Payment Exchange (APX) 2.0 

APX 2.0 takes secure credit card and ACH payment processing to another level. Firms already 
using APX will appreciate the significant improvements. New users will benefit from the 
accelerated Onboarding Experience, which will get them up and running in APX 2.0 within 
minutes! 

Seamless Integration 

Abacus Payment Exchange is fully integrated within Amicus Attorney. It streamlines your billing 
and collections by taking care of your credit card and ACH payment processing needs. This 
allows you to focus more energy on your practice. Designed for law firms, APX handles both 
operating and trust account transactions and ensures trust deposits remain whole. There is no 
duplicate entries of information into multiple systems.. 

Updated Interface 

Key improvements have been introduced to the look and feel of the APX 2.0 platform. Forms for 
entering credit card and banking information have an improved usability for both firm members 
and clients using the Client Portal. Even the onboarding screens have been updated to make it 
easier for new firms to start using the system. Ease-of-use improvements abound.. 

New PayNow Email Templates 

The PayNow capability lets you email payment links with your invoices to clients so they can 
quickly pay their bills. This capability dramatically reduces the collection time for firms. The new 
HTML payment request template ensures a more professional look and feel when sending 
PayNow links to your clients. The elegant new design is great right out of the box, but firms can 
also customize the look and feel of the payment request template with any HTML editor. 

Improved Pay Now Customer Experience 

Clients who receive a PayNow request email will also appreciate an improved experience. 
Clients can view the details about their invoices and outstanding payments, and easily add new 
credit card or ACH details to pay their bills. They can also save card or account details for use on 
future payments to speed up transactions. 

New APX Portal to track payments 

APX 2.0 includes access to the new APX Portal where firms can get an even greater insight into 
their payment processing. New reports, charts and graphs allow you to track payments and 
monitor trends from an elegant dashboard with options to drill down for more details. 

Improved APX Reporting 

The updated APX Transaction Report makes reconciliations much easier since it now references 
the Client Name, Matter ID and File Name. There is no need to run reports from multiple 
sources. All the information you need is contained in the APX transaction report, and available at 
your fingertips!. 
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Simple Onboarding 

APX 2.0 includes access to the new APX Portal where firms can get an even greater insight into 
their payment processing. New reports, chWhen you decide to make the move to APX 2.0, the 
Onboarding process is a breeze. You do not have to wait for approval. Firms can start processing 
payments immediately after signup. The 2-3 business day wait times are a thing of the past. Sign 
up today so you can start taking advantage of APX 2.0! 

New Recurring Payments 

Amicus now leverages the power of APX 2.0 to support recurring payment options that schedule 
payment processing. With weekly, bi-weekly, monthly and quarterly options, you are in control 
of when payments should be made. You can even do one-off scheduled payments for a later 
date, that does not require a recurrence pattern. Payments can be made to operating or trust 
accounts as needed. 

June 2021 

New Interface 

We are pleased to announce the rollout of our new User Interface (UI) for Amicus 20.7. The 
same great workflows, features and functionality that Amicus users have been accustomed to 
have been maintained in the updated UI. 

Dashboards 

• The Home screen dashboards on the ATTORNEY-side and BILLING-side give you an up-to-
date summary of the various aspects of your practice. 

New Notification changes 

• A new alerting system includes alerts and prompts when synchronization goes off-line for 
any reason. 

More Dynamic File Details 

• The updated UI maximizes the entire screen real estate in our File Details dialogs meaning 
that you can explore more data without scrolling. The reading panes have been improved, 
“People on File” is now hidden, and the vertical layouts have been switched to horizontal 
layouts. 

Clear Search Tool 

• A new Clear Search tool displays in the Amicus taskbar after a search has been completed in 
select modules. 

Enhanced Security 

• Our enhanced security  for Exchange / Office 365 Connections tracks Contact, Calendar & 
Email Integrations and improves performance. Amicus now allows for Token-based 
authentication, although users can continue to connect using their Username and 
Password.  The XML manipulation API's have been replaced with Microsoft XML Core 
Services (MSXLM). 
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Daily Checks 

• There is now a nightly service that runs in the background to keep Amicus humming and a 
RefreshEventCache can pick back up where it left off. 

Optimizations 

• Amicus 20.7 has optimized its resources to handle the surge in virtual private network 
(VPN) usage resulting in significant improvement in the way Amicus handles auto-updates. 
Subsequent updates will benefit from this change. 

Reports 

• Improvements to our reports. 

Printing Options 

• New printing options that make it easy to print copies of emailed bills. 
June 2020 

Get Paid Faster - Accept Credit Cards link 

• It is now easier to sign up for APX (Abacus Payment Exchange) with the addition of a Get 
Paid Faster - Accept Credit Cards link in the Trust Receipt and Receive Payment dialog. 

March 2019 

Pay Now emails 

• You can now include an embedded URL provided by the Abacus PayNow service in emails for 
clients to click and easily make an APX payment. 

Reversing APX payment methods 

• APX now has the ability to reverse APX payment methods. 

APX Payment Method List 

• APX now has a new APX Payment Method List report that lists all Primary Clients with their 
Payment Method. 

Apply Taxes using Activity Codes 

• There is now an option to apply taxes individually on Time Entries using Activity Codes. 

New Security Profile 

• A new Security Profile allows the responsible lawyer to change time entries on draft bills. 

Expanded UTBMS Activity Code List 

• The UTBMS Activity Code list has been expanded. 

Reprint bills 

• Amicus Billing Users can now reprint Bills. 
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Referral Report 

• The new Referral report is a handy way to track how clients are being referred. The report 
can be filtered to display only necessary information. 

Managing edits to time entries 

•  A new Time and Fees Change Reason option activated by the firm Administrator appears at 
the bottom of theTime Entry Details dialog. 

Time and Fee Journal Report 

• Tracking changes has been added to the Time and Fee Journal report so you can see the 
reason for the time entry change when Include Corrections is selected on the report. 

APX 

• New videos have been created to show you how to Set up and Manage a Payment in APX. 
October 2018 

APX 

The following enhancements have been made to APX (Abacus Payment Exchange). 

• An existing payment method can now be edited. 
• You can now apply an APX - Credit Card / ACH payment while creating a bill on single, 

consolidated and split billing. 
• The Bill Summary report has been updated to include the APX payment option in the Payment 

amount field. 

Import Time/Fees and Expenses 
You can now import Time/Fees and Expenses (Client Costs) from a CSV file in both Amicus 
ATTORNEY and BILLING views. The Actions menu now includes the Import options of Time / 
Fees and Expenses. 

Activating and De-Activating [For Administators Only] 
There is now the capability to activate the Amicus Billingfunctionality at a later date for additional 
licenses. Updating Amicus Billing at a later date allows a user to continue to work and post time 
entries to other Billing softwares. 

A Use Amicus Billing checkbox has been added to the Time - Accounting System dialog. This can be 
accessed by selecting Accounting under the Time tab in Firm Settings. 

When an additional Amicus Attorney/Billing user license is purchased as a bundle users can toggle 
this selection on/off even after the Billing wizard is completed. 

Updating Billing Licenses [For Administrators Only] 
Amicus can be upgraded to include a Billing license in the Evaluation period. 
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Billing Behavior on Client Expense 
The Client Expense Details dialog has been updated to include Billing Behavior. This can be 
accessed from any module in the BILLING side. 

September 2018 

Address fields 
The five US Virgin Islands territories (American Samoa, Guam, Northern Mariana Islands, Puerto 
Rico, U.S. Virgin Islands) have been added to the State Address pull-down lists: 

• For the following dialogs: 
o Credit Card payment method 
o E-Check payment method 

• On the following tabs during the Onboarding process: 
o Firm Address Basic Details tab 
o Home Address on Personal Information tab 
o Addresses on the Verification tab 

• Client Portal — Clients can now view and share their invoices in the new Billing module of the 
Client Portal. As well, they can make payments via credit card and ACH. Afterwards they 
can generate and print a report of all Client Portal billing activities 

• Billing Security — a heightened security feature has been added which enables the user to 
control access while performing billing functions and viewing of certain billing modules and 
reports. 

• APX — Abacus Payment Exchange (APX) is a payment solution that uses a single platform to 
process accounts and bill clients so you get paid the same day. With APX, there are no 
hidden fees or long-term contracts. Only a 3% flat fee is charged for credit card 
transactions. APX accepts most payment options including Mastercard, Visa, E-Checks, 
ACH, American Express, and Discover. 

• APX - Credit Card and ACH Report — A new report has been added to the Reports module 
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Getting Around 
 

Getting Around 
 

In Amicus Billing, navigating to your records, accessing commands, working with lists, and so on 
are mostly the same. If you are a Billing User, the Navigation Pane has a tab to switch between the 
Attorney side and the Billing side. 

 
 Related Topics 

• Billing Users and Billing Supervisors 
• Amicus Navigation Pane 
• The modules 
• Amicus Floating Toolbar 
• Billing Home Screen 
• Getting help 
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Getting Around> Billing Users and Billing Supervisors 
 

Billing Users and Billing Supervisors 
 

The Billing Security Profiles feature allows firms to have more control and flexibility in assigning 
Firm members access to billing functions. 

Actions are hidden from a Firm Member when they do not have access to the function. 

To accommodate firms with existing experience using Amicus Billing predefined security profiles 
have been included. 

Default levels of access 

• Billing Supervisor– Users assigned to this role have the highest level of access. This 
role is uneditable by the firm. Billing Supervisors manage all billable files and primary 
clients for the firm (including restricted billable files and clients). They can create / edit 
/ delete all billing related transactions. By default, only Billing Supervisors can access 
the Trust and Billing modules. 
 

• Billing User Access – This is the most common security profile. Firm Members with this 
security profile can create billing related transactions for files they can access. 
However; they cannot access all modules/grids such asDailies, Trustand Billing. Firms 
can edit this profile to customize it to their needs. To access Other Firm Member’s Files 
and Contacts ensure that this option is enabled on the Attorney side. 
 

• No Billing Access–A firm member without access to any of the billing functions. This is 
an Amicus Attorney user with a Billing Profile set to No Access. A Firm cannot edit this 
profile. 
 

 

Note: 

 In addition, a Firm Administrator can create new Billing Security Profiles. 
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Profile Assignments 
1. Profile Assignments are set for new Billing Licensed Firm Members. 

• ForAdministrators the Billing Security Profile is set to Billing Supervisor. 
• For all other new firm members the Billing Security Profile is set to No Access. 

2. TheAdministratorassigns a Billing Profile to Billing firm members. 
 

3. An existing Billing Security Profile can be used as a template for a new profile by 
selecting the Copybutton. 
 

4. The copy inherits the settings of the copied security profile. Access to Billing functions 
is determined by your Firm Member designation, set by the Amicus Administrator. 

 

Related Topics 

• Getting Around 
• Amicus Navigation Pane 
• The modules 
• Amicus Floating Toolbar 
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Getting Around > Amicus Navigation Pane 
 

Amicus Navigation Pane 
 

TheAmicus Navigation Pane provides tabs for switching between the Attorney and Billing sides 
of Amicus, as well as controls for switching between modules and filtering the Index lists of 
items. It may also provide additional controls and information. 
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The Attorney-Billing tabs at the top allow you to flip between 
the two sides of Amicus. 

• The name of the module is identified near the top. 
• The control panel in the middle section provides: 

o Various filter controls 
o Navigation lists 
o Date assignment mini-calendars 
o Commands 
o Information, etc., appropriate to the current 

view. 
Secondary windows and dialogs may also have a control panel. 

The tabs at the top enable you to quickly switch between 
Billing modules or Attorney modules. 

Drag the divider above the Office button downward to make 
more space for the control panel section. 

The wide buttons will change to icons across the bottom. 
 

 

 

 

 
 

 

 

Related Topics 

• Getting Around in Navigator View 
• The modules 
• Amicus Floating Toolbar 
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Getting Around > The modules 
 

The Modules 
 

The module you have open is shown in the main window. Switching to another module changes 
the content of that window, rather than opening a separate window. 

 

Note: 

 Each time you open a File or Contact/Client record, a separate window appears 
allowing several Files and Contact/Client records to be open at the same time, in 
addition to the main module window. Similarly, you can have open multiple Time 
Entries, Expense Entries, Receive Payments, Trust Receipts, and so on. 

 

You can easily access a module from the Navigation Pane or the View menu. Also keep in mind 
that Amicus is highly integrated—for example, while working on a File you can access the Clients 
associated with it, the accumulated Time Entries and Expenses, the related Bills and Payments, 
and so on. 

Some of the Billing-side modules correspond to Attorney-side modules, but some are available 
on only one side or the other. The following modules are available on the Billing side. Note that 
you can switch your view of an individual File or Contact/Client details dialog between the 
Attorney and Billing side independently of the side currently shown in modules or other details 
dialogs. 
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Use this module To do this 

 

Set your preferences for how Amicus works, use the Help 
Center, perform administrative tasks if you have access 
rights, or exit Amicus. 

This matches the Attorney-side Office module, with only a few 
differences. 

 
Work with your client matter files. 

This corresponds to the Attorney-side Files module. 

 

View contact information for individuals and companies, 
and a firm directory. Maintain current phone, address, 
and related details on all your clients. 

This corresponds to the Attorney-side People module. 

 

Manage your billable and non-billable time spent and the 
client expenses accrued. 

This corresponds to the Attorney-side Time Sheets module. 

 
Manage your client trust funds. (Although all Billing Users 
have access to Trust functions from other modules, only 
Billing Supervisors have access to the Trust module.) 

 

View and create client file bills, enter bill payments, do bill 
write-ups/downs, and generate reminder statements. 
(Although all Billing Users have access to billing functions 
from other modules, only Billing Supervisors have access 
to the Billing module.) 

 Run reports. Customize reports and templates. 

 

Related Topics 

• Getting Around 
• Amicus Navigation Pane 
• Amicus Floating Toolbar 
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Getting Around > Amicus Floating Toolbar 
 

Amicus Floating Toolbar 
 

If you are a Billing User or Billing Supervisor, the Amicus Floating Toolbarincludes Billing-related 
navigation controls: Trust, Billing, and Reports. 
 

 

 

Related Topics 

• Getting Around 
• Amicus Navigation Pane 
• The modules 
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Getting Around > Billing Home Screen 
 

 The Billing Home Screen 
 

The Billing Home screen provides convenient access to the commonly used Billing functions. It is 
the default screen on the BILLING side of the Office module and is also available from the 
Navigation pane. 
 

 

Click a tile or on a dashboard to go to a list view or choose a secondary function from a pull-
down list. 

Click the plus icon to quickly add a new File, Time Entry, Expense, Trust Receipt, Trust Check,File to 
File Transfer or Draft Bill. 
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Click a tile in the Navigator section to go to the corresponding dialog. Click on the Tip of the day 
to go to the corresponding Online Help. Click Start Timer to quickly start the Amicus timer. 

For more information, see Getting Around. 

Related Topics 

• Getting Around 
• Amicus Navigation Pane 
• The modules 
• Amicus Floating Toolbar 
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Getting Around in Navigator View > Getting Help 
 

Getting Help 
 

"Amicus Attorney User Help", "Amicus Administrator Help", "Amicus Billing User Help" and "Amicus Billing 
Administrator Help" are available from theHelp Buttonon the right-hand side of themenubar in any 
module. 
 

 

ClickOffice > Help Centerto view  the Amicus Help Center. Here you will find User and Administrator 
Help to supplement the main help, as well as Support, Contact Information and Other Resources, or 
check the Amicus Attorney Technical Resource Guides/Updates section on our website. 

Related Topics 

• Getting Around in Navigator View 
• Amicus Navigation Pane 
• The modules 
• Amicus Floating Toolbar 

 

https://www.abacusnext.com/amicus-attorney-technical-resource-guides-updates
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Setting Up Your Office 

 

Setting Up Your Office 
 

Out of the box, the Amicus Attorney modules and features are set up in such a way as to meet 
the needs of most users. However, you can customize the application to your exact 
specifications. 

To view or change any of your preferences, choose Office > Preferencesin the Navigation Pane. 
Or, for preferences relevant to a particular module, you can choose Tools > Preferences on the 
top menu for that module. 

The Preferences view and dialogs are the nearly same on the Billing side as on the Attorney side. 
The differences are: 

• My Application - Defaults on Login preferences 
• Dailies Dashboard pages 

For all other preferences, see the Amicus Help Center or User Guide. 
 
 

  



Amicus Billing User Guide  26
   
 

Setting Up Your Office > My Application - Defaults on Login preferences 

 

My Application - Defaults on Login preferences 
 

To set your defaults on Login: 

1. Select Office > Preferences to display the Preferences window. 
 

2. Select Defaults on Login under theMy Application heading. 
 

 
 

3. In this view, you can specify the following Billing-side related settings: 
• Choose whether the Attorney or Billing side is displayed first at login by 

selecting the appropriate radio button. 
 

4. If you choose to display theBilling side first, the option to select whose Office opens 
automatically is not available. 
 

5. Logout of Amicus Attorney and log back in to view the changes. 
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Setting Up Your Office > Dailies Dashboard pages 

 

Dailies Dashboard pages 
 

Three Billing-related graphical data views are available for your Billing-side Dailies Pages. These 
views (Dashboard elements) are included in the Billing Manager Dailies Page, but you can also 
add them to other Dailies Pages of your own design. 

Creating a new Dashboard Page 
To create a new Dashboard Page for your Dailies module, select Preferences from the sidebar 
control panel in the Officemodule to display the Preferences window. 

1. Select Dailies Pages under the Dailies heading and click New to display the New Dailies 
Page dialog box. 
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2. Complete the fields as follows: 
 

• Select the Add a Dashboard Page radio button. 
• Select the appropriate radio button under Create my new Dashboard: 

 

 
 

• Enter the new Dashboard Page Name. 
 

3. Click OK. The Dashboard Designer appears-see the next section. 

Designing a Dashboard Page 
The Dashboard Designer allows you to select, place, size, and define your choice of Dashboard 
elements. 
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Adding Sections 
Add one or more Sections to a Page. Each Section represents a Data View. The control panel at 
the left displays the lists of available Data Views. The Billing graphical Data Views are in the 
Other Views list. 

Display the appropriate list in the control panel and then either double-click the desired Data 
View or drag-and-drop it to the desired position. A Section displaying that Data View is created 
automatically. Resize and move the Section as desired. 

 

Tip: 

 You can add more than one copy of the same Data Views to the same Page. For 
example, that way you could easily compare the Time Fee Collection data for 
different filter settings, such as different date ranges of different Responsible 
Lawyers. 
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 The three Billing-related Data Views, available under the "Other Views" heading, are: 

• Work in Progress view: The table and pie chart in this element show how much work was 
performed but not yet billed-for the last 30 days, the 30-day period before that, and 
so on. 
 

• Accounts Receivable view:The table and pie chart in this element show how much 
work was billed but not yet collected-for the last 30 days, the 30-day period before 
that, and so on. 
 

• Time/Fee Collection view: The bar chart in this element shows how much work was 
performed, how much was billed, and how much was collected-month by month over 
a selected date range. 

For more details about using these views, see Billing Manager. 

Related Topics: 

• Setting Up Your Office 
• Dailies Dashboard pages 
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Dailies 

 

Dailies 
 

Once the firm is licensed for Amicus Billing, two additional pages are shown to Billing Users in 
the Billing-side Dailies module: 

Today's Billing Reminders 

 

Amicus can optionally alert you about various billing-related conditions on Active Files: Files that 
have Total WIP exceeding a threshold amount, Files that have Draft Bills (ready for review), Files 
on which no Payments have been received recently, and so on. 

These alerts are set for each File, from the Admin > File Alerts view of the Billing-side File 
Details. 

Some alerts appear for the Responsible Lawyer only, and some can be set to appear for various 
Billing Users. For more information, see Setting Billing alerts for a File. 
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Billing Manager 
Amicus shows three graphical views of billing data: 

Work in Progress view 

• The table and pie chart in this element show how much work was performed but not 
yet billed-for the last 30 days, the 30-day period before that, and so on. 
 

 
 

• Show data for the Files you can access – either for the firm or limited to particular 
Responsible Lawyers, File Types, or Billing Categories. 
 Expenses are included. 
 

• Unposted Time Entries are not included, nor are Time Entries with Billing Behavior set 
to "No Charge - Show on Bill" or "No Charge - Don't Show on Bill". 
 

• Accounts Receivable view The table and pie chart in this element show how much work 
was billed but not yet collected-for the last 30 days, the 30-day period before that, 
and so on. 
 

 
• Show data for the Files you can access: either for the firm or limited to particular 

Responsible Lawyers, File Types, or Billing Categories. 
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Time/Fee Collection view 

The bar chart in this element shows how much work was performed, how much was billed, and 
how much was collected-month by month over a selected date range. 
 

• After you change a filter in this view, you must click Refresh to update the graph. 
 

 
 

• Show data for the date range you specify (up to 12 months). 
 

• Show data for the Files you can access: either for the firm or limited to particular 
Responsible Lawyers, Working Lawyers, File Types, or Billing Categories. 
 
o Working Lawyer: For fees entered, this is the Timekeeper on the Time Entries. For 

fees billed and fees collected, this is the Firm Member to whom the fees will be 
or have been distributed. 
 

o Unposted Time Entries are not included, nor are Expenses. 
 

Related Topics: 

• Setting Up Your Office 
• Dailies 
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Files 

 

Files 
 

The Files module on the Billing side is similar to the one on the Attorneyside, with some extra or 
slightly different functions and information available on only one side or the other. 

The Files module is where you coordinate all activities that are related to your client matter files. 
The information in Amicus Files is shared with modules on both Billing and Attorney sides as 
appropriate. 

On the Billing side, you will generally be working with Billable Files that have a Primary Client 
assigned. 

Use the Attorney-Billing buttons at the top of the control panel to switch between the Billing 
and Attorney versions of the Files Index or particular File Details. 

Related Topics 

• Adding a File 
• Looking up Files 
• Using the Files Index 
• Working with File details 
• People on a File 
• Filling in accounting information for a File 
• Setting Billing alerts for a File 
• Working with transactions on a File 
• Using other information on a File 
• Refunding General Retainer 
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Files > Adding a File 

 

Adding a File 
 

When adding a file in Amicus Billing you can set the following requirements on billable files : 

• Client IDand Matter ID 
 
o Automatically provide the next available Client IDand/or Matter ID and, if so, 

might or might not let users change that ID. If you can and do change an 
automatic ID, you will be asked whether you'd like to reset the next available ID 
for the firm (to the number following the one you entered) 
 

1. To set requirements on billable files select Office > Firm Settings to display the Firm 
Settings window. 
 

2. Select Client and File Numbering under the Billing heading to display the Firm Settings 
dialog box. 
 

 
3. Complete the fields by selecting the checkboxes and entering information in the 

corresponding fields or selecting options from the pull-down menu. 
 

4. Click Run Duplicate Checker to ensure that you don't start the number with an invoice 
number already in the system. 
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Note: 

Adding a File on the Billing-side is the same as adding one on the Attorney-side. 

 

Related Topics: 

• Looking up Files 
• Using the Files Index 
• Files 
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Files > Looking up Files 

 

Looking up Files 
 

You can look up Files on theBilling side in various ways: 

• In the Files Index—see Using the Files Index. 
• Using the QuickFind Files function in the Files Index. 
• Doing a Whose File Is It? search—this is the same as on the Attorney side. For details, 

see the "Files > Looking up Files > Whose File Is It? searching" topic in the Attorney User 
Help or User Guide. 

• Using the Select Files dialog to associate Files with other records—see the "Common 
Functions > Selecting Files" topic in the Attorney User Help or User Guide. 

The global Search function is available only on the Attorney side. For details, see the "Search" 
topic in the Attorney User Help or User Guide. 

Related Topics 

• Files 
• Adding a File 
• Using the Files Index 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=ugsearch.htm
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Files > Using the Files Index 

 

Using the Files Index 
 

The Files Index window appears when you open the Files module. It shows a list of your Files, 
filtered according to your preference settings. 

1. To open the Billing-side Files Index, click the Files button in the Navigation Pane, 
and if necessary, click Billing at the top of the Navigation Pane. 
 

 
 

2. The File list shows information such as the Client Matter ID, File Name, and balances for 
WIP Fees and Expenses, AR, Trust, and General Retainer. 
 

• Above the list, a title indicates how many Files are shown in the current list. At 
the bottom of the list, totals for the currency columns appear. 
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Showing particular kinds of Files 
You may have a large number of Files. Using options in the control panel, you can filter the list of 
Files shown. 

Depending on your assigned Security Profile or Firm Member Designations, you might have the 
following option: select Firm Files to show all Files regardless of whether you are assigned to 
them, or select My Files to show only the Files to which you are assigned. 

• Filter the list to show Files for "All" Firm Members, or only Files for selected assigned 
"Firm Members', "Responsible Lawyers", or "Introducing Lawyers". 

• Filter the list to show Files for "All" Clients, or only Files for selected assigned 
"Clients" or "Primary Clients". 

• Optionally, filter the list to include only those Files with non-zero balances for AR, 
WIP, both AR and WIP, or AR and/or WIP. 

 
Related Topics 

• Files 
• Adding a File 
• Looking up Files 
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Files > Working with File details 

 

Working with File details 
 

On the Billing side, theFile Details window includes information about Firm Members and Clients 
on the File, related Files, transactions on the File (Time/Fees, Billing, Trust, etc.), and bill images. 
General, accounting, and billing settings are also available. 
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File brad views 

To display a particular view of the File Details window, use the navigation list in the control 
panel. 
 

 

Related Topics 

• Restricting access to a File 
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Files > Working with File details > Restricting access 

 

Restricting access to a File 
 

File Restriction settings are the same on the Billing side as on the Attorney side, and affect both 
sides. 

To restrict a File: 

1. Click the Restrictbutton near the bottom of the control panel in the File Details window 
to display theRestrictions dialog box. 
 

 
 

2. Select the desired options, and click OK. The no-entry image on the Restrictbutton 
turns red. 
 

3. Billing Supervisors can access the Billing side of all Billable Files, including Files they are 
not assigned to and Files that are Restricted. 
 

Related Topics 

• Restricting access to a File 
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Files > People on a File 

 

People on a File 
 

You can view and edit a list of the People associated with the File, or change information about 
them, or contact them. The list may include Firm Members and Contacts. 

This topic covers: 

• Looking up People on a File 
• Assigning a Person to the File 
• Specifying a Client's billing information on a File 
• Specifying information for a Firm Member on the File 

You can e-mail, call, and otherwise contact People on the File from the Billing side, just as from 
the Attorney side. For details, see the "Getting in touch with People on a File" topic in the Attorney 
User Help. 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=Getting_in_touch_with_People_on_a_File.htm
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Files > People on a File > Looking up People on a File 

 

Looking up People on a File 
 

You can see and change information about thePeople associated with a File in the People section 
of the File Detailswindow. This feature is somewhat different on the Billing side. 

 

At the top of the People section is a list of People associated with the File. For Clients (or Client-
classified Contacts), the list indicates whether bills should be sent to them and shows the 
attention or cc name (if any). The list is filtered by your selection of options at the top of the 
control panel (see below). 

In the list, the Primary Clienton the File is shown in bold. 

The lower part of thePeople section shows details about the Person currently selected in the list 
of People on the File. The Business Cardshows the Person's contact information. For a Client, 
the area below the Business Card controls whether bills should be sent to them, the attention or 
cc name (if any) to be used on those bills, and the mailing address. 

Filtering the People list 
You can use options at the top of the control panel to limit the People list to only Firm Members, 
or only Contacts whose Role on the File is classified as a Client Role. 
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Files > People on a File > Assigning a Person to the File 

 

Assigning a Person to the File 
 

At any time, you may add or remove Firm Members or Clients on the File. Any Contact you 
assign to the File is automatically assigned the "Client" Role on the File (and assigned to the 
"Clients" Contact Group), and you can then edit the bills section below their Business Card to 
specify whether and how bills should be sent to them. 
 

Related Topics 

• People on a File 
• Specifying a Client's billing information on a File 
• Specifying information for a Firm Member on the File 
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Files > People on a File > Specifying a Client's billing information 

 

Specifying a Client's billing information 
 

On theBilling side of File Details, you can specify how Bills are sent to Clients and other Contacts. 
Copies may be sent to multiple Contacts if desired. 

Sending Bills to the address of a Client on the File 
In the People on the Filelist inFile Details: 

1. Select the Client whose name and address you want used on Bills. (This is the Primary 
Client by default, but you may select a different Client.) 
 

 
• Select the Send Bill To checkbox. 

 
• Optionally, override the default name that will appear on the Bill (the Client's 

Full Name). Click Edit Bill To Name and enter the desired text—for example, Mr. 
& Mrs. Smith. Note that a typed-in name will not be affected by any subsequent 
changes to the name of the Client in their Client record. 
 

2. Select which of the Client's addresses to use (e.g. their Business Address). 
 

• Optionally, set Bills to include an Attention line with the name of another 
Contact—for example, if the Primary Client is a Company, you could send Bills to 
the Company with an Attention line that names a particular Contact at the 
Company. Select the Alternate Contact checkbox and Attention option, and then 
click the Select People icon and select the desired Contact. 
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Sending Bills to the address of a Contact who is not a Client on the File 
For example, you might want to send Bills directly to a Client's accountant at the accountant's 
address. 

1. In the People on the File list in File Details, select the Client whose name you want used 
on Bills. (This may be the Primary Client or another Client.) 
 

 
 

2. Select the Send Bill To checkbox. 
 

3. Optionally, override the default name that will appear on the Bill (the Client's Full 
Name). Click Edit Bill To Name and enter the desired text. Note that a typed-in name 
will not change if the name of the Client is later changed in their Client record. 
 

4. Select the Alternate Contactcheckbox and c/o option, and then click the Select People 
icon and select the desired Contact. 

5. Select which of the c/o Contact's addresses to use (e.g. their Business Address). 
 

Related Topics 

• People on a File 
• Assigning a Person to the File 
• Specifying information for a Firm Member on the File 
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Files > People on a File > Specifying information for a Firm Member 

 

Specifying information for a Firm Member 
 

In Amicus Billing, you can mark a Firm Member on the File as the Introducing Lawyer, that is, the 
person who brought the matter to the firm. 

To choose this designation, select Introducing Lawyers from the dropdown list in the Navigation 
pane and click the People icon to select the lawyer(s) from the Select People window. 

 

Related Topics 

• People on a File 
• Assigning a Person to the File 
• Specifying a Client's billing information on a File 
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Files > Filling in accounting information 

 

Filling in accounting information 
 

Use the Admin > Accounting brad view of theFile Detailswindow to fill in client and matter 
information, billing information, and accounting link details. 
 

 

Note: 

 Some of the fields in this brad view are crucial for the proper functioning of the 
link between Amicus Attorney and your accounting system. For more 
information, see the relevant  

Link Guide, available from the Office Help Center. 

 
 Related Topics: 

• Filling in general client and matter information for a File 
• Filling in basic billing information for a File 
• Filling in billing settings for a File 
• Split Billing 
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Files > Filling in accounting information > Filling in general client and matter information 

 

Filling in general client and matter information 
 

To fill in client and matter information for a File, open the File Details window, choose Admin > 
Accounting on the navigation list in the control panel. 

The top right section of the Admin Accounting brad view provides the client matter fields. 

As on the Attorney side, specify the Primary Client, client and matter names and IDs, and so on. 
 

 

Specifying the primary client 

To specify the Primary Client on the File, click the People Select button and select the relevant 
Contact. If the Contact already has a Client ID, it will be automatically assigned to the File. 

Specifying client and matter names 

The Client and Matter Names default from the Primary Client selected and Short File Name 
entered. Edit them if necessary. 
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Specifying Client and Matter IDs 

If you select an existing Primary Client who has a Client ID, their ID is provided. 

For new Files and new Primary Clients, the Client ID and/or Matter ID might be automatically 
provided. If so, you might be able to override the defaults. These features depend on your Billing 
firm settings. 

If required, ensure that a Client ID and Matter ID are specified. The Client ID must be unique—a 
Client cannot have more than one Client ID, and two Client cannot share the same Client ID. 
Depending on your firm settings, Matter ID must be fully unique, or merely unique for the 
particular selected Client. 

 

Related Topics: 

• Filling in accounting information 
• Filling in basic billing information 
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Files > Filling in accounting information > Filling in basic billing information 

 

Filling in basic billing information 
 

To fill in basic billing information for a File, open the File Details window, choose Admin > 
Accounting on the navigation list in the control panel. 

• The bottom section of the Admin > Accounting brad view provides the basic billing 
information fields for the File Billing Category, File Billing Rate (or Time Tracking Rate), 
and a Task-Based Billing option. For details on these fields, see the corresponding 
topic in the Attorney User Help or User Guide. an E-billing option is also provided. 
 

 
    

• Percentage—on the Billing-side version of this view, a Percentage field is available if 
the File Billing Rate is set to "Contingency". Specify the percentage of the 
Judgement/Settlement amount that will go to the firm. A Firm Setting determines 
whether the amount that goes to the firm covers both fees and client expenses, or 
fees only (leaving client expenses to be charged separately). 
 

 
    

• E-bill Type—If the File is set for Task-Based Billing, you may additionally set it for E-
billing. Select the LEDES 1998B, LAS (Legalgard/Litigation Advisor), or Chubb format. 
When a Bill on the File is posted, an E-bill format version of the Bill will be 
automatically generated. (Enter E-bill information in the Custom Page provided—see 
Working with the E-billing Custom Page.) 
 

 
 
 Additional billing options can be set for the File in the Admin > Bill Settingsview. 
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Files > Filling in accounting information > Filling in billing settings for a File 

 

Filling in billing settings for a File 
 

While basic billing settings for a File are available in the Admin > Accounting brad view (Billing 
Category, Billing Rate, etc.), many additional settings are provided in the Admin > Bill 
Settings brad view on the Billing-side File Details window. 
 

 

Assigning a Bill Profile 
Settings for many of the options in this view can be provided by assigning a Bill Profile. 

When you create a new File, an appropriate Bill Profile is automatically assigned: the Profile 
assigned to the File's Primary Client (if any), else the default Profile for the firm. You may assign 
a different Profile at any time by selecting it in the Use Bill Profile pull-down list. 

If the Amicus Administrator later changes the settings for any options in the Bill Profile, those 
changes will apply in all existing Files assigned that Profile. 
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If a user later changes the Bill Profile assignment for the Primary Client (in the Balances view of 
Client Details), they may optionally change the Profile assigned in all existing Files for that 
Primary Client. 

Customizing the settings for a File 
If you wish to edit any of the Bill Profile-controlled options, first select the Customize Bill Profile 
option to disassociate the File from any Profiles. If the Amicus Administrator later changes the 
settings for options in the Bill Profile, those changes apply will not apply in this File. 

Saving your customized settings as a new Bill Profile 
If you have customized Bill Profile-controlled options for a File, you may click Save Settings as 
New Bill Profile to create a new Profile with those settings and assign that Profile to this File. 
You and other Firm Members can then assign the Profile to other Files as desired. 

Bill Profile-controlled options 
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• Templates—Select the Bill and Reminder Statement Templates. You can set the 
Reminder Statement Template to "Use Firm Setting", which means the Template 
specified for the firm in Billing - Interest and Reminder Statements. The Bill Template 
is used only if the File is Billed via "Bill Single File" rather than as a Consolidated Bill for 
the Client. 
 
If the File uses a Retainer trigger or is involved in Split Billing, choose the "Standard 
New" Bill Template. 
 
Templates can be created and edited from the Reports module. To see a sample 
printout for your selected Template, click Preview.  
 

• Retainers & Billing—Choose whether Trust on a File is applied to new charges when a 
Bill is posted. 
 

• Mass Billing—Choose whether the File is excluded from Mass Billing (that is, only allow 
Single File Billing), and whether only Expenses (not Fees) will be Mass Billed (e.g. in 
Contingency Files). 
 

• Billing Behavior—If a Fixed Fee File, or a Billable File with a Quoted Amount, is included 
in Mass Billing, choose what to do if the Fees amount is greater than the Fixed 
Fee/Quoted amount: bill the Fees amount, adjust the Fees amount down to the Fixed 
Fee/Quoted amount, or exclude this File from the Mass Billing run. Similarly, choose 
what to do if the Fees amount is less than the Fixed Fee/Quoted amount. 
 
If the Fees amount on a Fixed Fee File, or a Billable File with a Quoted Amount, is 
reduced at the time of billing (either manually in Single File Billing or automatically in 
Mass Billing), choose whether to show that reduction as a Courtesy Discount item on 
the Bill or simply adjust the Fees total without explanation.  
 

• Interest and Reminder Statements—Choose whether the File is included when mass 
generating Reminder Statements. Also choose whether interest is charged on the File 
and those charges appear on Bills and Reminder Statements. (Interest is charged on 
the File only if interest is charged at the firm, as determined by the Billing - Interest & 
Reminder Statement setting.) 

E-mail Bills options 
These options effect the case where: 

• A Firm Member posts multiple Bills together, regardless of whether or not they have 
E-mail Integration enabled 

• A Firm Member who does not have E-mail Integration enabled posts a single Bill. 
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Choose whether any Bill for this File will be selected by default for e-mailing. 
 

 

Additionally, choose where the Bill e-mail will be sent by default: to the Primary Client's primary 
e-mail address (specified in their Contact record) or to the alternate e-mail address you specify 
here. To send e-mails to multiple addresses, enter them here, separated by a semicolon (e.g. 
johndoe@gmail.com; sskinner@springfieldeschool.com)—the Bill e-mail will be sent To the first 
address, and Cc the other addresses. 

Retainers & Billing options 
Choose whether a minimum Trust or General Retainer balance should be maintained for the File 
and if so, set the minimum and trigger (threshold) amounts. If the balance falls below the trigger 
amount, Bills on the File can request the Client to replenish the balance. For example, if you set a 
minimum balance amount of $5,000 and a trigger of $1,000, and the File's balance falls from 
$1,500 to $900, the Bill can request a replenishment of (5,000-900)= $4,100. 

 

If you set this feature for a File, be sure to set the File to use the "Standard New" Bill Template. 
(The Template may be edited to suit your firm's needs.) 
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Quotes and Discounts options 
• For Billable Files—Choose whether to set a quote or discount for the File and, if so, 

which. 
 

 
 
 If using a Quoted Amount, enter the Fee Quote. The Billing Behavior options 
(described above) determine how this affects Bills. 
 
 If using a Discount to Fees, enter the Discount percentage or flat amount to be 
applied in the Bill. If Mass Billing, the Discount calculation is applied automatically. If 
Single File Billing, the user is given the choice of applying the Discount or not. 

• For Fixed Fee Files—The Fee Amount for the File, set in the Admin > Accounting 
view, is shown here. The Billing Behavior options (described above) determine how 
this affects Bills. 
 

 

• For Contingency Files—The Contingency Rate (Percentage) for the File, set in the 
Admin > Accounting view, is shown here. When a Judgement/Settlement amount is 
available, enter it so that Fees can be automatically calculated. 
 

 
•  For Task-Based Billing Files—The Fees are billed. Quotes and discounts are not 

applicable. 
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Lawyer Fee Distribution options 
These options determine how Fees are distributed among lawyers (Timekeepers) when 
Payments are made by clients. 

• Payment Method—Choose whether to distribute all Fees to the Responsible Lawyer 
on the File, or prorate Fees based on the dollar value of each Timekeeper's work on 
the Bill being paid, or distribute Fees based on a flat percentage specified for each 
Timekeeper. 
 

 

• Origination Fee—To distribute a percentage of Total Fees to one or more 
Timekeepers for having brought the client matter to the firm, click Edit and, in the 
Fee Distribution Details dialog that appears, select each of those Timekeepers and 
set their percentage. These Fees are distributed first, and the remaining amount is 
distributed as determined by the Payment Method. 
 
 These Timekeepers do not need to have done work on the File, or even be assigned 
to it. No relationship is imposed between this option and the Originating Lawyer 
designated for the File. 
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• Percentage Splits—If the Payment Method is "Based on Percentage", use the 
Percentage Splits section of the Fee Distribution Details dialog to select the 
Timekeepers to receive Fees distributions. In % Splits, set each Timekeeper's 
percentage, to be calculated on the Fees amount that remains after Origination Fees 
are subtracted. The Net % column shows the Timekeeper's percentage of Total Fees 
adjusted for Origination Fees. 100% must be allocated. 
 

 

Split Billing options 
When billing, you can have Fees and Expenses from a "Master" File) always allocated amongst it 
and one or more other "Sub" Files. For details, see Split Billing. 
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Tax options 
If the firm charges Sales Taxes on Fees and/or Expenses, choose whether they apply to this File. 
(The general Tax options are set for the firm by your Amicus Administrator.) 
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Files > Filling in accounting information > Split Billing 

 

Split Billing 
 

You might be doing work for multiple Clients and want to split fees and expenses between two 
or more of them. For example, you could set up a class action case this way. Or you might want 
to allocate the Fees and Expenses on one File to other Files for the same Client. 

Amicus lets you create a "Master" File in which you enter all Fees and Expenses that are to be 
split among it and the "Sub" Files. Billing the Master File will automatically create separate Bills: 
one for the Master File and one for each of the Sub Files. The Sub Bills also include any 
individual Sub File Fees and Expenses. 

Note that you can still bill a Sub File separately if you like. 

Setup 
1. In the File Details of the file you want to set as the Master File, select Admin > Bill 

Settings from the left navigation pane to display the Bill Settings view. 
 

 
 

2. In the Lawyer Fee Distribution and Split Billing section, check the Split Fees between 
File Matters option. 
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3. The Split Billing Details dialog displays. 
 

 
◦ Choose whether to split the Fees, Expenses, or both. 
◦ The first File listed is the Master File. Add other Files as Sub Files for splitting the 

charges. 
◦ Enter the percent allocation(s) of the total charge for each File. If you set the 

Master File's allocation(s) to zero, its Fees/Expenses will be entirely allocated to 
the Bills on Sub Files. 

1. Ensure that the Master and Sub Files are set to use the "Standard New" Bill Template. 
(The Template may be edited to suit your firm's needs.) 
 
In order to be included in a Split Billing group, a File must: 

• Be Open and Active. 

• Not be assigned a "Non-Billable" File Billing Category (in the Admin > Accounting 
view). 

• Not be set for Task-Based Billing (in the Admin > Accounting view), and thus not set 
for E-billing. 

• Not belong to an existing Split Billing group. That is, a File cannot be the Sub of more 
than one Master, or serve as both Sub and Master. 

• Not be part of a consolidated billing arrangement for a Client 
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Split Billing option in a Sub File: 
• Once a File has been specified as a Sub File, the Split Billing option in its Admin > Bill 

Settings view will be disabled. 

Other details 
• Fixed Fee or Contingency: 

 
o The Master File's settings are used, and thus affect the amounts allocated to Sub 

Files when billing. 
 

o The Sub Files' settings are ignored. 
 

• Time and Expenses: On the Master File, create the Time and Expense Entries to be 
split. Ones created on Sub Files will only affect Bills on those particular Files. 
 

• Creating Bills: 
 
o In order to Bill the Master File (with its Sub Files), none of the Sub Files can 

already have a current Draft Bill, Final Bill, or Reminder Statement. 
 

o When you Bill the Master File (with its Sub Files), the Sub File Bills will include 
both allocated Fees/Expenses and any Sub File-specific Fees/Expenses within 
the billing period. 
 

o For convenience, the Select Files dialog includes a "Split Billing" option to list 
just Master Files. 
 

• Mass Billing: Split Billing Files are always excluded from Mass Billing. The Mass Billing 
options (in a File's Bill Settings) are ignored. 
 

• Fee Discounts: 
 
o The Master File's "Apply Discounts to Fees" setting (in Bill Settings) is ignored. 

 
o Each Sub File's "Apply Discounts to Fees" setting affects fees allocated from the 

Master File as well as fees from Time Entries on that specific File. 
• Taxes, Trust and General Retainer transfers, and Fee Distributions: Specific to the 

individual Bills. 
 

• Payments, Write-Ups/Downs, Reminder Statements, and Interest on Bills: Perform on 
the individual Bills. 
 

• Undoing or deleting Bills: Undoes/deletes all Bills associated with the split, not 
individual Master or Sub Files. 
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Files > Setting Billing Alerts 

 

Setting Billing Alerts for a File 
 

Use the Admin > File Alerts brad view of the Billing-side File Details window to select File billing 
activity conditions upon which the Responsible Lawyer and/or selected Firm Members should 
be alerted. 

These alerts will appear in the Today's Billing Reminders section of the Billing-side Dailies module. 
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WIP (Work in Progress) alerts 
Set alerts to warn the Responsible Lawyer when the Total WIP (fees plus expenses) balance, 
WIP Fees balance, or WIP Expenses balances: 

• Exceeds the amount you specify 
• Includes an item (Fee and/or Expense) older than the number of days you specify 

Billing alerts 
Set alerts to warn the selected Billing Users when: 

• A Draft Bill exists (and thus is ready for review) 
• No Bills have been posted within the specified number of days, or the most recent 

AR date of a posted Bill is older than the specified number of days (assuming that 
the File is Active) 

Accounts Receivable alerts 
Set alerts to warn the selected Billing Users when: 

• The AR balance is greater than the specified amount 
• The account is getting stale—an unpaid Bill is older than the specified number of 

days 
• It's been too long since payment—no Payments (or Trust or General Retainer 

transactions) have been received on any unpaid Bills for the specified number of 
days 

• Money is owing (AR balance) but funds are available in Trust or General Retainer 
• The Trust or General Retainer balance is less than the trigger specified for the File 

(and thus needs to be replenished) 

 

Related Topics 

• Filling in billing settings for a File 
• Creating Bills 
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Files > Working with transactions on a File 

 

Working with transactions on a File 
 

The Transactionsviews of File Details provide a detail list of billing transactions on the File and 
an account overview below. Each of these views shows the same overview but a different detail 
list: 

• All Transactions (File account overview) 
 

• Time/Fee transactions 
 

• Expense transactions 
 

• Bill transactions 
 

• Trust transactions 
 

• General Retainer transactions 
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Files > Working with transactions on a File > File account overview 

 

File account overview 
 

To view a summary of transactions on a File, go to the BILLING side of the File Details window 
and navigate to any of theTransactions views. 

 

The table shows current balances for the File: 

• Unposted—Unposted hours and Fees (including any Non-Billable or No Charge Time). 
• Posted—Posted hours, Fees, and Expenses—both unbilled and billed. (including any 

Non-Billable or No Charge Time). Items on Draft and Final Bills are included. 
• WIP (Work In Progress)—Posted but unbilled hours and Fees, and unbilled Expenses 

(excluding any Non-Billable items). Items on unposted Bills sitting in Draft or Final 
are included. 

• Billed—Billed hours, Fees, Expenses, Taxes, and Interest. Posted Interest is included, 
memo interest is not. Fees, Expenses, and Taxes reflect any adjustments made at the 
time of billing or later via Write Ups/Downs. Only items on posted Bills are included. 

• Write Up/Down—Write Up/Down amounts for Fees, Expenses, Taxes, and Interest. 
• Paid—Paid Fees, Expenses, Taxes, and Interest. 
• Accounts Receivable—AR balances (billed but not-yet-paid) for Fees, Expenses, Taxes, 

and Interest. 

Below the table are shown additional balances and dates for the File: 

• Trust balance 
• General Retainer balance 
• When the File was last billed (AR date of the last Bill) 
• When a Payment against a Bill was last received on the File (excluding receipt of 

General Retainer or Trust) 
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Drilling down to detail information 
If an account overview value appears underlined when you move the cursor over it, you can drill 
down to related details. For example, click the WIP Fees amount to display the Time/Fees view 
filtered to hide billed, unposted, Non-Billable, and No Charge Time. Or click the Last Billed date 
to display the Bills view with the last Bill highlighted. 

Hiding the overview 
You may sometimes want to expand the details section of the Transactions view to see more 
items. To hide the overview, simply click the down arrow icon at the right of the Account 
Overview heading. To redisplay the overview afterward, click the up arrow icon. 
 

Related Topics 

• Files 
• Working with transactions on a File 
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Files > Working with transactions on a File > Time/Fee transaction details 

 

 Time/Fee transaction details 
 

To see Time/Fee transactions on a File, open theTime/Feesview of File Details. Or open the All 
Transactionsview and, if necessary, sort by Type. 

 

The types of Time/Fee transactions listed are: hourly Time Entries ("Time"), Flat Rate or File Fee 
Time Entries ("FR"), and Fee Adjustments ("Fee Adj", done at the time of billing). 

The information shown includes the transaction date, Timekeeper ("Initials"), hours (for Time 
Entries), Billing Rate (for Billable and No Charge Time Entries), amount, Invoice Number (of the 
Bill which includes the Time Entry or Fee Adjustment), and status. 

The Invoice Number may be: blank, "Draft", "Final", or a number (if the transaction is included on 
a posted Bill). 
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The Time Entry status may be: 

• Unposted— not yet posted 
• No Charge—set to "No Charge" and posted (billed or not billed) 
• WIP—set to "Bill" and posted but not yet billed 
• Billed—set to "Bill" and billed 

Filtering the list 
In the All Transactionsview, you may filter transactions by date range and choose to include 
billed only, unbilled only, or both. 

Additionally, in the Time/Fees view, you can choose to include unposted Time Entries and Flat 
Rate Fees, Non-Billable Time Entries, and/or No Charge Time Entries. Or you may choose to 
show only unposted Time Entries and Flat Rate Fees. 

Related Topics 

• Files 
• Working with transactions on a File 
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Files > Working with transactions on a File > Expense transaction details 

 

Expense transaction details 
 

To see Expense transactions on a File, open the Expenses view of File Details. Or open the All 
Transactionsview and, if necessary, sort by Type. 

 

 

The information shown for an Expense includes the transaction date, Expense Code (if any), 
reference number (if any), units and per unit rate or flat rate (if appropriate), amount, and Invoice 
Number of the Bill on which the Expense is included (or "Draft" or "Final" if included on a Bill 
that is not yet posted). 

Working with transactions 
To open the details of an Expense for viewing, editing, or deleting, double-click it. 

Filtering the list 
In the All Transactions and Expenses views, you may filter transactions by date range and choose 
to include billed only, unbilled only, or both. 

Related Topics 

• Files 
• Working with transactions on a File 
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Files > Working with transactions on a File > Bill transaction details 

 

Bill transaction details 
 

To see Bill transactions on a File open the Bills view of File Details. Or open the All Transactions view 
and, if necessary, sort by Type. 

 

The information shown for a Bill includes the AR Date, Invoice Number, new charges (Fees, 
Expenses, Taxes, and total), amount paid, outstanding balance owed, and aging (for outstanding 
Bills, the number of days since the AR Date). 

Invoice Numbers ending in an "i" (e.g. "2698i") indicate Bills for interest posted by Reminder 
Statements. 
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Bills view - transactions for a Bill 
In the Bills view, click the + icon for a Bill to expand the list, showing a sublist of the transactions 
on that Bill: 

• Bill—original Bill 
• WU/WD—Write-Ups and Write-Downs 
• Payment—Trust to AR Transfers done at the time of billing or later, General Retainers 

applied at the time of billing or later, or Receive Payments done after billing 
The transactions are shown in date sequence from oldest to newest. For each transaction, the 
list shows the date, Invoice Number or reference number, amount, and resulting outstanding 
balance. 

All view - transactions for a Bill 
In the All Transactions view, Write-Ups/Downs and Payments are listed. Payments include 
Receive Payments done after billing, Trust to AR Transfers done at the time of billing or later, 
and General Retainers applied at the time of billing or later. 

Filtering the list 
In the All Transactions view, you may filter transactions by date range and choose whether to 
include bills. 

Additionally, in the Bills view, you may choose to include paid bills only (those with no 
outstanding balance), outstanding bills only (those not paid in full), or both. 

Accessing a Draft or Final Bill on the File 
The list does not show a Draft or Final Bill on the File, if any. To access that Bill, click the 
Transactions button and choose Bill. 

 

Related Topics 

• Files 
• Working with transactions on a File 
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Files > Working with transactions on a File > Trust transaction details 

 

 Trust transaction details 
 

To see Trust check and receipt transactions on a File open the Trust view of File Details. Or open 
the All Transactions view and, if necessary, sort by Type. 

 

The information shown for a Trust transaction includes the transaction date, Trust Bank 
Account, check or receipt number, who the check is to or the receipt is from, the receipt or 
check amount, and the Invoice Number of the Bill on which Trust was applied (if any). 

Filtering the list 
In the All Transactions view, you may filter transactions by date range. 

Additionally, in theTrust view, you may choose to include checks only, receipts only, or both. If 
the firm has more than one Trust Bank Account, you may choose to show transactions for a 
particular one. 
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Files > Working with transactions on a File > General Retainer transaction details 

 

General Retainer transaction details 
 

To see General Retainer transaction details on a File, open theGeneral Retainersview of File 
Details. Or open the All Transactions view and, if necessary, sort by Type. 
 

 

The information shown for a General Retainer transaction includes the transaction date, Bank 
Account, and additional information depending on the type of transaction: 

• Retainer receipt: receipt number, who the receipt is from, amount. 
• Retainer application: Invoice Number of the Bill on which retainer was applied and the 

amount applied), Bank Account balance after the transaction. 
• Retainer refund: check number, who the receipt is to, amount. 
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Filtering the list 
In the All Transactions view, you may filter transactions by date range. 

Additionally, in the General Retainers view, you may choose to show General Retainer receipts 
only, applications only, refunds only, or all types. 

Related Topics 

• Files 
• Working with transactions on a File 
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Files > Using other information on a File 

 

Using other information on a File 
 

You can view and work with other useful information related to a File: the Bill Images view 
(described below) and the Related Files view (which, as on the Attorney side, allows you to set 
and view a list of Files that are related to this one). 

Working with Bill images 
To open the PDF or Word images of posted Bills on a File, go to the BILLING-side of the File 
Details window and navigate to the Bill Images brad view. Images of Reminder Statements 
posted with interest are also accessible. These images are also available from the Billing Index. 

 

Note: Your Administrator has a Firm Setting to control whether the images for Bills 
(and Reminder Statements posted with interest) are automatically saved in PDF 
format, Word format, or both. 

 

 

You can: 

• Open the PDF or Word image of a Bill or Reminder Statement 
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• Send the PDF (else Word) image of a Bill, or a Reminder Statement posted with 
interest, as an attachment on an e-mail to the Primary Client (if E-mail Integration is 
enabled) 

• Open the E-bill text version on a Bill (created if the File was set for E-billing) 
• Send the E-bill version of a Bill as an attachment on an e-mail to the vendor (if E-mail 

Integration is enabled) 
• Delete the PDF, Word, and E-bill versions of a Bill or Reminder Statement 

 

TIP: If you do not have E-mail Integration enabled, you may instead open the PDF and 
then send it as an e-mail attachment from the Amicus Tasks Toolbar (assuming you 
have enabled that Toolbar in Adobe Reader or Acrobat). 

Working with the E-billing Custom Page 
If the File is set to use a standard e-billing format (LEDES 1998B, Legalgard/Litigation Advisor, 
or Chubb), a special Custom Page is provided so that you may enter the additional information 
required in the E-bill. From the Billing side of the File Details window, navigate to the Custom 
Pages > E-bill Information or E-bill Information (Chubb) view and complete the fields. 
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Related Topics 

• Files 
• Working with transactions on a File 

  



Amicus Billing User Guide  80
   
 

Files > Refunding General Retainer 

 

Refunding General Retainer 
 

Use the General Retainer Refund function to reimburse General Retainer funds on a File back to a 
Client. 

TIP: If your firm has set up a "petty cash" or "slush fund" File and paid General Retainer funds on 
it, you can use this function as a simple way to write checks from a General Bank Account. 

Creating a Refund 
On a Billing-side File Details window: 

2. Select General Retainers from the navigation pane on the left and select New >Retainer 
Refund. 
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3. The General Retainer Refund dialog box displays: 
 

 

4. Enter basic information for the check: 

◦ From—Trust Bank Account from which money is being withdrawn. 
◦ Check #—Optional identification number. 
◦ Date—Date of the check. 
◦ To—The name of the person to whom payment is being made. 
◦ Amount—Dollar value of money being paid. 
◦ Type—Method of payment (check or other). 
◦ Description—Description of the payment. 
◦ File—Which File's General Retainer is being refunded. Balances for this File are 

shown at the bottom of the screen. 
5. If Refund check printing is allowed at your firm (as set by your Amicus Administrator), and 

the payment Type is "Check", then a Print option is available at the right. Select that 
option to have a check printed when you Save the transaction. 

6. Select the Show Refund on Bill option if you want this transaction shown on the Client's 
next Bill on this File. 

7. Click Save & New or Save & Close to save the Refund. 

When a Refund is saved, Minimum Retainer Balance on the File is disabled. 

Printing checks 
The Amicus Administrator can set your firm to allow General Retainer Refund to check printing 
and if so, whether to print automatically or ask first. 
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A check can be output in the following ways: 

• When you save a new General Retainer Refund (if you've selected the Print option). 
• When you open an existing General Retainer Refund and either click Print (if the 

check was not previously printed), or click Reprint (if allowed by your Administrator). 
• When you run the Checks report from the Reports module (including reprinting if 

allowed). 

Related Topics 

• Files 
• Working with transactions on a File 
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Clients 
 

Clients 
 

The Clients module on the Billing side is similar to the People module on the Attorney side, with 
some extra or slightly different functions and information available on only one side or the other. 

On the Billing side, you will working with Contacts who have a Client-classified Role on one or 
more Files (regardless of whether or not they are assigned to the "Clients" Contact Group). 

The Firm Directory is also available on the Billing side, as on the Attorney side. 

Use the Attorney-Billing buttons at the top of the control panel to switch between the Billing 
and Attorney versions of the Clients/People Index or particular Client/Person Details. 
 

Related Topics 

• Adding a Contact 
• Looking up Clients 
• Working with Client records 
• Working with a Client's details 
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Clients > Adding a Contact 
 

Adding a Contact 
 

When you add a new Contact from anywhere other than from People On The File list or Primary 
Client field in File Details, note that the Contact is not automatically assigned a Client-classified 
Roleon a File and so will not appear in the Billing-side Clients Index. This is the same even if you 
add the Contact from the Billing side. 

 

Related Topics 

• Clients 
• Looking up Clients 
• Working with Client records 
• Working with a Client's details 
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Clients > Looking up Clients 
 

Looking up Clients 
 

You can look upClients on the Billing side in various ways: 

• In the Clients Index—see Using the Clients Index. 
 

• Using the QuickFindfunction in theClients Index—see the "Finding Clients (QuickFind)" 
topic in the Attorney User Help or User Guide. 
 

• In thePeople On This File list in the File Details window—see People on a File. 
 

• Using the Select People dialog to associate People with records—see the Common 
Functions > Selecting Peopletopic in the Attorney User Help. 
 

• Doing a Whose File Is It? search—see the Files > Looking up Files > Whose File Is It?" 
Searching  topic in the Attorney User Help. 

The global Search function is available only on the Attorney side. For details, see the Search topic in 
the Attorney User Help. 

 

Related Topics 

• Adding a Contact 
• Working with Client records 
• Working with a Client's details 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=Selecting_People.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=Selecting_People.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=Whose_File_Is_It__Searching.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=Whose_File_Is_It__Searching.htm
https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=ugsearch.htm
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Clients > Looking up Clients > Using the Clients Index 
 

Using the Clients Index 
 

The Clients Indexwindow appears when you open the Clientsmodule on the Billing side. It shows 
a list of your Clients arranged alphabetically by name. 

This topic covers: 

• Showing particular kinds of Clients 
• Client balances and totals 
• Editing a Client's basic information or viewing a Client's details 
• Expanding a Client row and listing their Files 

 
To open the Clients Index, click the Clients navigation button in the Navigation Pane. Or, open 
the People Index on the Attorney side and then click the Billing button to switch to the Billing 
side. If the Clients Index is already open, clicking Clients merely brings that window to the 
foreground—it does not open a second copy of the Index. 
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For Clients, the list shows information such as the name of the Client, the Client ID, the Primary 
phone number, the Client ID, the WIP and AR balances, and the Trust and General Retainer 
balances. Above the list, a title indicates how many Clients are shown in the current list. Only 
Clients are shown—those Contacts who have a Client-classified Role on one or more Files. To 
sort the list by the information in a column, click the column heading. 

For the Firm Directory, the list shows the same information as on the Attorney side: the name of 
the Firm Member, the Company Name, the Primary phone number, and the Firm Groups to 
which they belong. You may filter the Firm Directory the same way as on the Attorney side. 

Showing particular kinds of Clients 
You may have a large number of Clients. Using options in the control panel, you can filter the list 
of Clients shown (assuming that you first select the Clients option to show only Clients, rather 
than selecting Firm Directory to show only Firm Members). 

• Depending on your assigned Security Profile or Firm Member Designations, you 
might have the following option: select Firm Clients to show all Clients regardless of 
whether you are assigned to them or select My Clients to show only the Clients to 
which you are assigned. 

• Filter the list to show "All" Clients or only "Primary Clients" (those Clients who are 
Primary Client on one or more Files). 

• Optionally, filter the list to include only those Clients with non-zero balances for AR, 
WIP, both AR and WIP, or AR and/or WIP. 

Client balances and totals 
If filtering the list to show All Clients, the WIP, AR, Trust and General Retainer balances shown 
for each Client are the totals for all Files on which they have a Client-classified Role. If showing 
only Primary Clients, the balances shown for each Client are the totals for only those Files on 
which they are the Primary Client. 

The totals shown at the bottom of the Clients Index are the totals for the Files on which the 
Clients you have filtered the list to are the Primary Client. 

The balances and totals include only those Open Billable Files that you have permission to view. 

Editing a Client's basic information or viewing a Client's details 
As on the Attorney side, you can open the Person Edit dialog for a particular Client by selecting 
them, right-clicking on the list, and choosing Edit on the shortcut menu that appears. Or to view 
the Person Details record for a particular Client, double-click them in the list. 

Expanding a Client row and listing their Files 
In the Clients Index, the number of Open Billable Files each Client is on is shown in parenthesis 
to the right of their name. To expand the Client row and show these Files in a sublist, click the 
"+" icon to the left of their name. 



Amicus Billing User Guide  88
   
 

 

 

 

For each File, the File name, Client Matter ID, Responsible Lawyer, and WIP, AR, Trust, and 
General Retainer balances are shown. You can double-click a File to open its Details dialog. 

If the list is filtered to show All Clients, all Files on which the Client has a Client-classified Role 
are shown in the sublist (and those on which they are the Primary Client are shown in bold). If 
showing only Primary Clients, only those Files on which they are the Primary Client are shown. 

Only those Files that you have permission to view are shown. 

To collapse the File list for a Client, click the "-" icon to the left of their name. 

 

Related Topics 

• Adding a Contact 
• Looking up Clients 
• Working with Client records 
• Working with a Client's details 
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Clients > Working with Client records 
 

Working with Client records 
 

As on the Attorney side, you can print information about Clients, generate documents from their 
records, have Amicus assist you in getting in touch or keeping in contact, change Firm Member 
assignments, change Group assignments, and check for duplicates. 

 
Related Topics 

• Adding a Contact 
• Looking up Clients 
• Working with a Client's details 
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Clients > Using the Client Portal 
 

Using the Client Portal 
 

Once a Client has received their Client Portal invitation e-mail, clicked the link in it, and set up 
their access, they can log in to the Portal. 

 

What a Client can see in the Portal: 

•  Files that have been shared to them. 
• Shared Documents, Notes, Appointments, and Tasks on those Files—from separate 

modules or from the Details views of the associated File. 
• Invoices that have been shared. 

 

Note:  For privacy and security reasons, Clients are provided limited information. For 
example, a File's Summary is not shown. 

 
 What a Client can do in the Portal: 

• Add new Documents on their shared Files. These are automatically shared, and 
assigned to the File's Responsible Lawyer. 

• Clients may download an existing shared document, edit it, and upload it as a new, 
separate Document. 

• If Documents are Amicus-Managed at your firm, Clients may also Check Out/In the 
current version of an existing shared Document. 
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• Add new Notes on any of the shared Files (and optionally on a Document or Event). 
These are automatically shared, and a Sticky Alert is sent to the File's Responsible 
Lawyer. 

• For privacy and security reasons, Clients cannot otherwise edit or delete existing 
items. 

• View and share their invoices. 
• Make payments via credit card and ACH. 
• Generate and print a report of Client Portal billing activities. 
• Remove APX Payment Methods 

 

Related Topics 

• Sharing Invoices 
• Viewing Invoices 
• Paying Invoices 
• Reporting 
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Clients > Using the Client Portal > Sharing Invoices 
 

Sharing Invoices 
 

The Client Portal allows you to share both paid and unpaid invoices with your client. Payments 
associated with a shared invoice are automatically shared. If a firm does not have APX enabled 
the 'Pay Now' option on the portal view is disabled. 

 

Note:  To learn more see Sharing Information via the Client Portal in the Amicus 
Attorney User Help. 

 

Each shared invoice will display an Invoice Number, Date and theTotal Payment amount Billed per 
invoice. The amount is net of write up/down and includes fees, expenses, taxes, and interest (if 
posted as AR). 
 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/UserHelp/index.htm#t=share-clientportal.htm
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Sharing invoices by default in the Client Portal 

To share finalized bills by default in the Client Portal: 

1. Open an available file in the BILLING-side, go to Admin > Bill Settings to display the following 
dialog: 
 

 

◦ An option Share new bills in Client Portal is visible and available only when a file is 
shared in the Client Portal. By default, it is unchecked. 
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2. Check Share new bills in Client Portal to automatically share new bills for single and mass 
billing. Also, invoices with or without an outstanding balance will be shared in the Client 
Portal. The following prompt message displays: 
 

 

3. Click Yes to close the dialog and flag all prior outstanding invoices on this file to be 
available in the Client Portal. 

◦ Go to the Bills screen to include paid invoices. 

 

Removing an invoice from the Client Portal 

To remove an invoice from the Client Portal: 

1. Select the invoice and click on the portal icon  to display the following prompt: 
 

 

2. Uncheck the Visible to clients on the file who have portal access box, select OK. 
 
The selected invoice is no longer shared in the Client Portal and the portal icon is removed from 
the Portal column. 
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Sharing invoices in the Client Portal 

1. Open a file with an invoice. The portal icon    displays at the top of files that 
have been shared. 
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2. Go the BILLING-side and select Bills. Click on the Portal option to display the following 

Portal Sharing message: 
 

 

3. Select the box beside Visible to clients on the file who have portal access. 
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4. Click OK to share the selected invoice in the portal or Cancel to return to the previous 
screen. 

 

Note: The Portal Sharingdialog option default is dependent on the invoices selected. 
 

• If you select an un-shared invoice(s) and click on the portal icon  the dialog 
option defaults to unchecked. 

• If you select a shared invoice(s) and click on the portal icon the dialog option defaults 
to checked. 

• If you select a mixture of shared and un-shared invoices and click on portal icon the 
dialog option defaults to checked. 

 

A portal icon is added to the portal column when an invoice is shared to indicate that the invoice 
is shared. 
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Deleting invoices in the Client Portal 

After reviewing your bills you may realize a mistake has been made. For example, the cutoff date 
on a bill was incorrect. 

 
Note:   There are multiple areas where you can delete an Invoice. 

 

1. An easy way to delete the bill in the BILLING-side is to go to Billing module and filter the 
list of invoices using the controls in the left pane. 

 

2. Highlight the invoice on the main screen and right-click to display a shortcut menu. 
Select Delete to delete the bill from the list. 

• If the invoice was shared in the Client Portal based on the file settings the following 
prompt displays: 
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◦ Click Yes to delete the selected invoice. 

• If the invoice was not shared in the Client Portal the following prompt displays: 
 

 
◦ Click Yes to delete the selected invoice. 

Viewing shared invoices with other shared items 

Open the File Details in theATTORNEY-side to display theFile Factsin the left navigation pane. The 
 selection displays the following: 
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• Date Shared 
◦ Date and time the invoice was shared 

• Subject 
◦ Lists the Invoice Number and the totals of the amount Billed and Paid at the time of 

sharing the invoice. 
• Shared By 

◦ Lists the Firm Member(s) who share the invoice. 

Related Topics 

• Using the Client Portal 
• Viewing Invoices 
• Paying Invoices 
• Client Portal Reporting 

 

  



Amicus Billing User Guide  101
   
 

Clients > Using the Client Portal > Viewing Invoices 
 

Viewing Invoices 
 

This topic covers: 

• Accessing the Invoice list 
• Viewing Payments 
• Viewing a Bill Image 
• Viewing History 

 

Accessing the Invoice list 

Log into the Client Portal to view the Bills tile on the Home Page and the Billing option on the 
Menu bar. 

 

• The Billing tile: 
◦ Lists the number of invoices available in the portal for all the shared files to the 

Client. For example, "You have 3 bills". 
◦ If no invoices are shared a message displays "There are no shared bills". 
◦ Mousing over the Billing tile changes the text to "Show me my bills". 

 
5. Click on the Bills tile or the Billing option on the Menu bar to open the Client Portal Billing 

module. All shared invoices for this client are listed. 
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6. Select an invoice and click on one of the following tabs in the Billing module: 

•  – Opens the selected file and defaults to the "Document" selection 
of the "File Details" screen.. This tab is disabled when an invoice is not selected. 

•  – Opens a PDF of the selected bill. This tab is disabled when an 
invoice is not selected. 

•   – Displays the invoice history including the billed amount and 
payments. This tab is disabled when an invoice is not selected. 

•  – Displays the invoice payments when a row has been 
selected. When an invoice has not been selected it is disabled. 

•  – Enabled only when the firm is APX enabled. This option allows 
you to take advantage of Abacus Payment Exchange (APX) service to make 
payments by Credit Card and ACH on outstanding invoices. Payment is the same as 
Receive Payment by the Client where the payment may be distributed to multiple 
files. 
◦ You can select "Pay Now" without having to select an invoice. 
◦ If there is an outstanding amount the option of an existing payment method is 

presented if there is already a payment method for this client. 

◾ This method is only available to the primary client on the file. 

◾ You can add a payment method. 

◾ Make a payment. 
◦ If there is no outstanding amount you will be able to add a payment method. 
◦ When making a payment you can select the amount you wish to pay. 

◾ Enter the amount you wish to pay. 

◾ The default amount to pay is the outstanding amount. 
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7. Filter the list of invoices using the controls in the left pane. 
 

 
 
Show – Choose from one of the following options: 
 
All – Lists all shared invoices for this user. This is the default. 
 
Outstanding – Lists shared invoices with an amount due and includes invoices with 
partial payment. 

Paid – List shared invoices with zero amount due. 
 
Date selection – Sorted by invoice date starting with the more recent invoice. There is no 
"To" option as the current date is always used when displaying the invoice list. 
 
 from – Defaults to the start of the current month. Use the calendar controls to change 
this date. 
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Viewing Payments 

To view the payments of the shared invoices: 

1. Click View Payments in the Billing module. When an invoice has been selected a screen 
displays the invoice payments from the most recent payment. 
 

 

2. The payment list is View Only. The columns consists of: 

◾ Date – Payment date. 

◾ Invoice – This is the invoice number the payment was applied against. 

◾ Receive From – Who made the payment. 

◾ Description – Prefix with "APX" if the payment was by APX. 

◾ Amount – This is the payment due. The amount is a strikeout if it is for 
voided and refunded transactions. Deleted regular transactions (non-APX) 
are not included. 

◦  The columns are updated when you select "Pay Now" and complete a payment 
by credit card or ACH. 

3. Click Close to return to the previous screen. 
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Viewing a Bill Image 

To review a shared invoice, select an invoice and click on View Bill. A PDF image of the bill displays 
in the Document Viewer. 

 

A message displays informing you to contact the firm if the image does not exist. 

A scrollbar becomes available if the page content cannot fit on the screen. If the invoice is multiple pages, 
click the next arrow to navigate to any subsequent pages. 

Click Download to save the image to your computer. Click Close to close the Document Viewer. 
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Viewing History 

Select an invoice and click View History to get a summary of the payments on the selected bill in 
date order starting with the most recent. 

Click Download to save the image to your computer.  Click Close to close the Document Viewer. 

 

Related Topics 

• Using the Client Portal 
• Sharing Invoices 
• Paying Invoices 
• Client Portal Reporting 
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Clients > Using the Client Portal > Paying Invoices 
 

Paying Invoices from the Billing Module 
 

The "Pay Now" feature is enabled only when the firm is APX enabled. This option allows your 
client to take advantage of Abacus Payment Exchange (APX) service to make payments by 
Credit Card and ACH on outstanding invoices. You can add a payment method even if there is 
no invoice to be paid. Void or Refund must be done at the firm level. 

You can make a partial payment or choose to pay multiple bills at the same time. You cannot 
overpay a bill. You cannot edit a payment transaction in the Client Portal after it has been 
submitted. This must be done by a firm member. 

 
Payment Methods  

All valid payment methods associated with the primary client on the file are available in the 
Client Portal. 

1. Log into the Client Portal and select the Billing module to see all the invoices shared in 
the portal for all the shared files. 
 

 

2. Click "Pay Now" to display the Payment screen. 

• If you select an invoice first the Payment screen will show the amount outstanding on 
the invoice in the Pay field. 
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• If you do not select an invoice the Payment screen shows the total outstanding on all 

currently shared invoices in the Client Portal 
 

 
• The Payment screen contains the following components: 

◦ Invoice – The first four numbers display followed with "..." if there are more 
invoices. 

◾ Click on "..." to display the remaining invoices. 
◦ Amount Due – Total amount left on the invoice(s). 
◦ Dated – The date you are making the payment. This field does not display if you 

are making a payment for multiple invoices. 
◦ Pay – The default payment is the full amount. 

◾ You can make a partial payment by clicking in this field and entering the 
amount you want to pay. 

◾ If the amount entered is more than the default, a message displays letting 
you know that this is not allowed. 

◦ File – The name of the file. This field does not display if you are making a 
payment for multiple invoices. 
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◦ Payment Method – This field contains the APX method that is being used to pay 
the invoice. 

◾ Select from the pull-down list if multiple payment methods exist and 
include both Credit Card and ACH. 

◾ Click Add to display the Payment Method dialog to add an alternate 
payment method or if "Payment method not available" displays in the 
textbox. SeeAdding a Payment Method. 

3. When you add a new Payment method it is automatically added to the primary client and 
becomes the current Payment Method. 
 

 

• A Payment Services Agreement appears at the bottom of the screen. 
4. Click Submit to activate the payment processing. The following message displays while 

waiting for a response from APX. 
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Note: When processing a payment on multiple invoices the default method 
implemented in Amicus Billing determines the payment distribution of fees, 
expenses, interest, and taxes. The payment starts with the oldest outstanding 
invoice, and then the next oldest until all payments are fully distributed.

 

• If the payment is successful, a receipt will be issued and the Payment screen closed. 
A Confirmation # is issued by APX. 
 

 
• If the payment is unsuccessful, a message prompt displays and you will be able to 

print a record of the failed payment with the Transaction ID. 
 

 
◦ An email is also sent to the lawyer. 

5. Click Print to print a hard copy of the receipt or click Close to return to the initial Client 
Portal screen. If the payment was unsuccessful you are returned to the Payment screen 
to make edits and retry. 
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6. The Paid column of the Billing module screen is updated with the successful payment and 
the Balance Due is reduced by the payment amount for the selected invoice. 

7. The new payment displays on the list when you select View Payment or View History. 

• For partial payments, the distribution of fees, expenses, interest, and taxes is applied 
using the "Payment Hierarchy" from the firm settings. 
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Removing APX Payment Methods via the Client Portal 

The option to pay invoices 24/7 via the Client Portal is beneficial to your firm, as well as your 
clients. The list of available payment methods can be cleaned up effortlessly. 

1. Click Remove to the right of the Payment Method field to remove a payment method 
from the dropdown menu. The Remove button is disabled if a payment method does 
not exist. 
 

 
2. Attempting to delete a payment method that is being used by a recurring payment 

schedule displays a prompt informing the user that the deletion is not possible. 
 

Adding a Payment Method 

The Add option on the payment screen is always enabled. Adding a payment method saves it to 
the primary client contact on the file in the Client Portal. 

1. Click Pay Now on the Billing module to display a Payment screen listing all the valid 
payment methods previously saved on the file primary contact. 
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2. Click Add to display an APX application screen. 
 

 

• Select either the Credit Card or E-Check / ACH radio button. 
• If you selected Credit Card select the card type and complete the following fields: 

◦ Name on Card – Enter your name as it appears on your credit card. 
◦ Clients Card Number – Enter the credit card number. 
◦ CVV Code – Enter the 3 or 4-digit security code on the back of your credit card. 
◦ Expiry Date – Use the calendar controls to enter the expiry date of your credit 

card. 
◦ Billing Address – Enter your billing address. 
◦ Send Email Receipt – Enter an email address. 

3. Click Submit to return to the Payment screen. The new valid payment method is saved to 
the primary client contact card. 

Related Topics 

• Using the Client Portal 
• Sharing Invoices 
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Clients > Using the Client Portal > Reporting 
 

Client Portal Reporting 
 

After sharing a number of documents, notes, and invoices in the Client Portal, you may like to 
view a report of your activities. 

Viewing of Shared Invoices on the Reports 

To view a list of the shared invoices: 

1. Go to Office > Reports > Client Portal. Then select All Client Portal Shared Records - 
Selected File and select the file you want. The following report displays. 
 

 

2. Invoices previously shared for the file are now included on the report in addition to the 
documents and notes shared on the file in the Client Portal. 
 
 The columns of each invoice are: 

◦ Bill Icon   
◦ Date Shared – Date and time the invoice was shared 
◦ Subject – Invoice Number 
◦ Shared By – The firm member who shared the record 
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Viewing of Client Portal Payments on the Report 

After receiving a sticky note that a client has made a payment to the Client Portal you may want 
to get a report on the payment along with other portal activities. 

1. Go to Office > Reports > Client Portal. Then select My New Client Portal Changes - Date 
Range to display a dialog box. Use the calendar controls to select a Start Date and use 
today's date for the End Date to display the following report. 
 

 

2. The report now includes bill payments made in the Client Portal for the selected date 
range. 
 
 Each billing row consists of: 

◦ Bill Icon  
◦ Date – Date and time of payment 
◦ Subject – Invoice Number and Amount of Payment 

 

Note: There can be multiple records on the same date and time when the payment is 
for multiple invoices. 

 

◦ File Name – File name associated with the paid invoice 
◦ Client – Primary Client name 

When a payment is applied to multiple invoices, list one row for each invoice the 
payment is allocated against. The displayed payment amount shows the amount applied 
to that invoice. 
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Viewing Portal Payments from the File Index 

In addition to running the report from Office > Reports, you can go to the File Index and click 
View Recent Client Portal Activity to run the report My New Client Portal Changes - Date Range for 
today's date. 

 

Email for Client Portal Payment 

This option can be set up in Amicus-ATTORNEY and BILLING. 

 

 
 Note: Email must be set up for the file in User Management. 

 

1. Open a file and go to Admin > General. 

2. Select the Email Client Portal Alerts checkbox and pick an option from the pull-down list. 

◦ Nightly digest to responsible Lawyer 
◦ Nightly digest to assigned Firm Members 
◦ Immediately to Responsible Lawyer 
◦ Immediately to assigned Firm Members 
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This is the current standard email for existing Client Portal functionality. The email is 
also sent to the distribution list on a successful Client Portal payment processing. 

3. In addition to the email notification, a sticky is sent to the responsible lawyer. 
 

 

 

 
 Note: When a Client Portal payment is unsuccessful a separate email is 
sent to the responsible lawyer. 
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Time, Fees and Expenses 

 

Time, Fees and Expenses 
 

The Time, Fees & Expenses module on the Billing side is similar to the Time Sheets module on the 
Attorney side, with some extra or slightly different functions and information available on only 
one side or the other. In particular, you can create Expense Entries from the Billing side, and 
Billing Supervisors can see firm-wide views of time and expenses. 

Use the Attorney-Billing buttons to switch between the Billing and Attorney versions of the 
module. 

This topic covers: 

• Creating Time Entries 
• Working with Time Entries 
• Tracking Time Entries 
• Creating & working with Expense Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Creating Time Entries 

 

Creating Time Entries 
 

You may create Time Entriesfrom both sides of Amicus. For example, choose File > New > Time 
Entryfrom the menu in any module. 

 

Filling in the Time Entry details 
The Time Entry Details dialog is the same regardless of whether you open it from the Billing or 
Attorney side of Amicus. 

Fill in details as desired: 

• Timekeeper (required) 
• File (required in order to post the Time Entry) 
• Date of activity (required) 
• Billing Category (non-editable, from the File selected) 
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• Billing Rate (required) 
• Activity Code 
• Activity Description 
• Duration 

Amicus Billing provides the following additional fields: 

• File settings and balances (display information only) 
• Billing Behavior 
• Total Fee 

File information and balances 
The Full Client Name, Full Matter Name, and Client/Matter ID appears at the upper left. For a billable 
File, additional information appears at the upper right: 

• Fee Arrangement (if any)—Contingency percentage, Fixed Fee amount, Discount 
percentage or amount, or Quoted amount. 

• WIP (Work In Progress)—total balance for unbilled Fees and Expenses. The Fees 
include only posted, billable, "Bill" items, and excludes any Non-Billable or No 
Charge items. Items on a Draft or Final Bill are included. 

• AR—Accounts Receivable total balance for billed but unpaid Fees, Expenses, Taxes, 
and Interest. Posted Interest is included; memo Interest is not.The total reflects any 
adjustments made either at the time of billing or later via Write Ups/Downs. 

Billing Behavior 
Indicate how the Time Entry should be treated when included in a Bill: 

• Bill—Add the Fee value to the Bill and, by default, show the Time Entry description, 
hours, and value. "Bill" Time Entries are included in WIP. 

• No Charge - Show On Bill—Do not add the Fee value to the Bill but, by default, show 
the Time Entry description and hours. Show the term "No Charge" in place of the 
value. For example, you might wish to show descriptions of the work done on a 
Contingency File. "No Charge" Time Entries are not included in WIP. 

• No Charge - Don't Show—Do not add the Fee value to the Bill and do not show any of 
the Time Entry information. You can nevertheless track time spent on the File (and 
therefore its profitability). On a Billable, Contingency, or Flat Fee File, the 
information is used for calculating Lawyer Fee Distribution. "No Charge" Time 
Entries are not included in WIP. 

Total Fee 
The value calculated for the Time Entry, generally Rate times Duration. However, for a Time 
Entry with Billing Rate set to "File Fee" or "Flat Rate", this is simply the Fee Amount. 
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Time, Fees and Expenses > Working with Time Entries 

 

Working with Time Entries 
 

Posting Time Entries 
Posting a Time Entry simply marks it as complete, and ready for including on a Bill. 

Billing-side totals affected: 

• Posted Hours and Fees on the File (excluding any Non-Billable or No Charge Time). 
• Work In Progress Hours and Fees on the File (excluding any Non-Billable or No 

Charge Time). 
Attorney-side totals affected: 

• Billable and Non-Billable Hours for the year, shown in the Statistics view of Time 
Sheets. 

• The total value of posted time on the File, shown in the Time Spent > All My Time view 
of File Details. 

Editing Time Entries 
You cannot unpost a posted Time Entry. However, it may be edited until it is included on a posted 
Bill. If it is on a Draft Bill, it can be edited only from the Draft Bills view of the Create Bills dialog. 
If it is on a Final Bill, the Bill must first be sent back to Draft. 
 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Creating and working with Expense Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Creating and working with Expense Entries 

 

Creating and working with Expense Entries 
 

You can create Client-recoverable Expenses from the BILLING side of Amicus. For example, choose 
File > New > Expense Entry from the menu in any Billing-side module. 
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Filling in the Expense Entry details 
Fill in details as desired: 

• File – Enter the name of the file 
• Date – Enter the date of activity 
• Reference number  – Enter a reference number (optional) 
• To – Enter the Vendor 
• Expense Code  – Select an expense code (optional) from the dropdown list 
• Hard Cost/Soft Cost flag—Hard Cost refers to "out-of-pocket" expenses, such as 

courier fees, private investigator charges, and court transcript fees. Soft Cost refers 
to other expenses, such as telephone calls and in-house photocopying. 

• Quantity, Unit Price, and Total cost, depending on how the Expense Code has been 
defined by your Administrator 

• Description – Add an activity description (optional) 
• Billing Behavior – Select an option from the pull-down list. The options are Bill, No 

Charge - Show on Bill and No Charge - Don't Show 
When finished, click OK or Save & New. 
 

Editing Expense Entries 

In general, an Expense Entry may be edited until it is included on a posted Bill. If it is on a Draft 
Bill, it can be edited only from the Draft Bills view of the Create Bills dialog. If it is on a Final Bill, 
the Bill must first be sent to Draft. 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Working with Time Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Managing edits 

 

 Managing Edits to Time Entries 
 

 

Important: The Time and Fees Change Reason feature must be activated by your 
Administrator. 

To track a change to a posted time/fee entry: 

1. Select Time, Fees & Expenses from the control panel to display theTime, Fees & 
Expenseswindow. 

2. Use the filters in the left pane to list the appropriate time entries. 
 

 

3. Select a Time Entry from the list and double-click or right-click and select Open from the 
pop-up menu to display theTime Entry Detailsdialog. 
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4. Making changes to the following fields will prompt you with the Time and Fees Change 
Reason dialog after you click OK. 

◦ Timekeeper 
◦ Billing Rate 
◦ Duration 

5. A Time and Fees Change Reason dialog prompts you to Select a reason for this change from the 
pull-down menu. 
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◦ The OK button is disabled until you select a reason. 
◦ Click Cancel to return to the Time entry Details window without saving the 

changes to the Time Entry. 
◦ Click OK to save the time entry changes and return to the Time, Fees & Expenses 

window. 
6. To display the Time Entry Details dialog with the change reason, re-open the Time Entry 

from the list. 
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◦  The Change Reason appears at the bottom. 
 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Working with Time Entries 
• Creating and working with Expense Entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Setting a default profile for Fees and Expenses 
 

Setting a default profile for Fees and Expenses 
 

Before you can use theImport Fees and Expenses feature you must enable a default profile. 

1.  Go to Firm Settings in the left pane, click on Time > Import to display the Firm Settings 
Time/Fees and Expense Import dialog. 
 

 

2. Select default profiles from the pull-down lists in the Time/Fee entries and Expense 
entries fields. 

3. Click OK to complete the process. 
 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Importing Fees and Expenses from CSV 
 

Importing Fees and Expenses from CSV 
 

You can import Fees/Time Entries and Expenses (Client Costs) from a CSV file from Amicus 
ATTTORNEY and BILLING views. 

To import Fees and Expenses into Amicus: 

1. Select Office >Actions in the main menu bar to display a pull-down list, click Import to 
display another window with Time/Fees and Expenses: 
 

 

2. Select Fees to display the Import - Time and Fees dialog. 
 

 
 
 OR Select Expenses to display the Import – Expenses dialog. 
 

 

◦ Check the First row in import file contains Field Names if the first row of the CSV file 
contains a header. 
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3. Enter the path and name of the CSV file you would like to import into the Data File field 
or click Browse to browse to the location of the CSV file. 

4. Select Import to start importing theTime/Fees or Expenses into Amicus. 

5. Use the View Log button to view the results of the import. 

 

Note: Records that are unable to be imported are listed in the log and saved in a 
separate file (Failed_Import.csv). Make corrections as needed and re-import these 
records.

 

 

 
 Note: UTBMS Task and Activity codes are required on all time entries for Task Based 
Billing.

 

If the file is UTBMS enabled, then both the Task code and UTBMS activity code should be on 
the import record. Otherwise, the record is treated as an exception and "Task Base Billing - Missing 
Task/Activity codes" displays when a user selects "View Log". 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Working with Time Entries 
• Creating and working with Expense Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Time, Fees and Expenses > Reviewing Time Entries and Expenses 

 

Reviewing Time Entries and Expenses 
 

On the Billing-side, the Time Fees & Expenses module provides the following two lists of items: 

• Time-Fees view 
• Client Expenses view 

Note that the Attorney side provides a useful Statistics view. 

 

Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Working with Time Entries 
• Creating and working with Expense Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 

  



Amicus Billing User Guide  132
   
 

Time, Fees and Expenses > Reviewing Time Entries and Expenses > Using the Time-Fees view 

 

Using the Time-Fees view 
 

By default, the Time-Fees view of theTime Fees & Expenses module shows today's Time Entries 
for all Timekeepers. Fee Adjustments done at the time of billing (in Bills that are now posted) are 
also included. The list omits any Time Entries that are not assigned to a File. 

To open the Time-Fees view, click the Time, Fees & Expenses button in the Navigation Pane, and 
if necessary, click Billing at the top of the Navigation Pane and select the Time-Fees option. 

 

By default, the Time-Fees list shows the item type (Time, Flat Rate, or Fee Adjustment done at 
the time of billing), date, Timekeeper, Client Matter ID, File Name, description, hours, Billing Rate 
(or Time Tracking Rate), amount, Invoice Number (or Bill Status) of the Bill that includes the item, 
and item status (see below). You can set the list to show the Audit ID and Primary Client Name 
as well. 
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The Time Entry status may be: 

• Unposted— not yet posted 
• No Charge—set to "No Charge" and posted (billed or not billed) 
• WIP—set to "Bill" and posted but not yet billed 
• Billed—set to "Bill" and billed 

At the bottom of the screen, totals are shown for the currently displayed list. Hours and fees are 
totalled for each item status. 

Showing particular kinds of items 
Using options in the control panel, you can filter the list of items shown. 

• Firm Files—By default, only the items on Files to which you are assigned are shown. 
Depending on your assigned Security Profile, "My Files" and "Firm Files" options 
might appear in the control panel. To show the items on all Files regardless of who is 
assigned to them, select the Firm Files option. Or, to show only the items on your 
Files, select the My Files option. 

• Dated—Show items for a specific date or date range. 
• Timekeepers—Show items for selected Timekeeper(s). 
• Include only Files where—Show items based on the Files to which they are assigned. 

Select the option and specify the details ofReviewing Time Entries and Expenses this 
File limitation: File Type, Primary Client(s), Responsible Lawyer(s), particular File(s), 
or Billing Category. 

• Type—Show all, "Time" only (duration-based total fee), or "Flat Fee" only (Flat Rate- 
or File Fee-based total fee). 

• Billing Status—Show all, unbilled only, or billed only. 
• Include Non-Billable 
• Include Unposted Entries 

 

Related Topics 

• Reviewing Time Entries and Expenses 
• Using the Client Expenses view 
• Viewing Time Statistics 
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Time, Fees and Expenses > Reviewing Time Entries and Expenses > Client Expenses view 

 

Using the Client Expenses view 
 

By default, the Client Expenses view of the Time Fees & Expenses module shows all Expense 
Entries. Expense Adjustments done at the time of billing (in Bills that are now posted) are also 
included. 

To open the Time-Fees view, click the Time, Fees & Expenses button in the Navigation Pane, and if 
necessary, click Billing at the top of the Navigation Pane and select the Client Expenses option. 

 

By default, the Client Expenses list shows the Expense type (Hard or Soft), date, Client Matter 
ID, Primary Client Name, File Name, Description, amount, and Invoice Number (or status) of the 
Bill that includes the Expense. You can set the list to show the Audit ID and Expense Reference 
Number as well. 

At the bottom of the screen, totals are shown for the currently displayed list. Hard Costs and 
Soft Costs are totalled for unbilled and billed Expenses separately. 
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Showing particular kinds of items 
Using options in the control panel, you can filter the list of items shown. 

• Firm Files—By default, only the Expenses on Files to which you are assigned are 
shown. Depending on your assigned Security Profile, "My Files" and "Firm Files" 
options might appear in the control panel. To show the Expenses on all Files 
regardless of who is assigned to them, select the Firm Files option. Or, to show only 
the Expenses on your Files, select the My Files option. 

• Dated—Show Expenses for a specific date or date range. 
• Include only Files where—Show Expenses based on the Files to which they are 

assigned. Select the option and specify the details of the File limitation: File Type, 
Client(s), Responsible Lawyer(s), File(s), or Billing Category. 

• Billing Status—Show all, unbilled only, or billed only. 
• Type—Show all, Hard Cost Expenses only, or Soft Cost Expenses only. 

 

Related Topics 

• Reviewing Time Entries and Expenses 
• Using the Time-Fees view 
• Viewing Time Statistics 

  



Amicus Billing User Guide  136
   
 

Time, Fees and Expenses > Reviewing Time Entries and Expenses > Viewing Time Statistics 

 

Viewing Time Statistics 
 

On the ATTORNEY-side, the Statistics view of the Time Sheets module provides a graph of your 
actual billable time and goals for the month or year. 

If you are a Billing Supervisor, or are assigned a Security Profile with appropriate rights, you can 
choose to show the statistics for another Timekeeper. 

To view Statistics on the ATTORNEY-side: 

• Click the Time Sheets module in the left navigation bar and select the Statistics tab at 
the top. 

 

Related Topics 

• Reviewing Time Entries and Expenses 
• Using the Time-Fees view 
• Using the Client Expenses view 
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Time, Fees and Expenses > Searching Time Entries 

 

Searching Time Entries 
 

The Quick Find function provides different options on the BILLING-side than on the ATTORNEY-
side. 

1. To search your Time Entries, click theQuickFindbutton at the top of the Time, Fees & 
Expenses module to display the Find Time Entries dialog box. 
 

 

Specifying your search criteria 
2. Choose whether to search All Time Entries or only Entries Shown in the Index, and specify 

one or more of the following the search criteria: 

◦ Select an option from the pull-down menu of the Entries with the Billing Category 
of field 

◦ Click the checkbox beside Activity Description contains and enter text in the 
corresponding textbox 

◦ Click the checkbox beside Activity Code is to enable the corresponding icon 

◾ Click on the icon to display the Select Activity Code dialog box 
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◾ Double-click on an option to select it and close the dialog box or select an 
option under the All Activity Codes list and use the arrow buttons to move it 
to the Current Selection window 

◦ Click the checkbox beside Task based Billing Task Code is to enable the 
corresponding icon 

◾ Click on the icon to display the Select Task-Based Task Codes window 

◾ Double-click on an option to select it and close the dialog box or select an 
option under the Task-Based Billing Task Codes list and use the arrow 
buttons to move it to the Current Selection window 

◦ Click the checkbox beside Task based Billing Activity is to enable the corresponding 
icon 

◾ Click on the icon to display the Select Task-Based Billing Activity Codes 
window 

◾ Double-click on an option to select it and close the dialog box or select an 
option under the Task-Based Billing Activity Codes list and use the arrow 
buttons to move it to the Current Selection window 

3. Click OK to begin the process. 

 
 Related Topics 

• Time, Fees and Expenses 
• Creating Time Entries 
• Working with Time Entries 
• Creating and working with Expense Entries 
• Managing edits to time entries 
• Setting a default profile for Fees and Expenses 
• Importing Fees and Expenses from CSV 
• Reviewing Time Entries & Expenses 
• Mass change to Time Entries 

  



Amicus Billing User Guide  139
   
 

Time, Fees and Expenses > Mass change to Time Entries 

 

Mass change to Time Entries 
 

The Mass Time Entry Changefunction, available only toBilling Supervisorson the Billing side, 
provides a quick way to change the Billing Rateor Billing Behaviorfor multiple unbilled Time 
Entries. 

1. To perform a mass change, select one or more Time Entries in the Time-Feesview of 
the Time, Fees & Expensesmodule and choose Tools >Mass Time Entry Change to 
display theMass Time Entry Changedialog. 
 

 
 

2. Choose whether to change theRateor Billing Behavior in Time Entries. 
 

3. If you choose to change the Rate from or to "Other", enter a correspondingRate 
Valueas well. Then clickOK. The function will skip any of the selected Time Entries that 
are already billed, or that do not meet theFromcriteria, or that cannot be changed 
because the To Rate is not available for the assigned Timekeeper. 

 

Related Topics 

• Time, Fees and Expenses 
• Reviewing Time Entries & Expenses 
• Searching Time Entries 
• Mass change to Time Entries 
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Trust 
 

Trust 
 

TheTrust module, which is available only on the BILLING-side of Amicus, is where you manage 
your client trust accounts. 

Law firms often receive client funds that are deposited into a general bank account or trust bank 
accounts before a bill is issued. These "unearned" funds are called retainers, where "unearned" 
simply means the payment has not yet been applied against a bill. Retainers are normally used 
against future services for which the client will be billed. The firm might require a retainer before 
starting work on a client file. 

Trust funds are funds held by the firm in one or more separate client bank accounts called trust 
or escrow accounts. These funds might include retainers. 

A firm might commonly use general retainers rather than trust retainers. General Retainers 
(sometimes called "unearned retainers" or simply "retainers") are funds held in the firm's general 
operating bank account. 

TheTrust module provides functions for: 

• Receiving trust funds from clients—see Receiving Trust. 
 

• Issuing trust checks to pay client expenses from trust funds—see Paying Expenses from Trust 
(Trust Checks). 
 

• Transferring trust funds to AR to pay client bills or WIP expenses—see Transferring Trust to 
AR. 
 

• Transferring trust funds between Files within the same trust account—see Transferring Trust 
between Files. 
 

• Trust funds can also be automatically transferred to AR to pay a Bill when the Bill is 
posted. For details, see Billing a single File. 
 

• To refund General Retainer, see Refunding General Retainer. 
 

Related Topics 

• Looking up Trust 
• Receiving Trust 
• Paying Expenses from Trust 
• Transferring Trust to AR 
• Transferring Trust between Files 
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Trust > Looking up Trust 
 

Looking up Trust 
 

On the Billing side, you can look up Trust transactions in various ways: 

• In the Trust Index—see Using the Trust Index. 
• Select All Transactions > Trust in theFile Details—see Working with transactions on a File. 

 
Related Topics 

• Trust 
• Receiving Trust 
• Paying Expenses from Trust 
• Transferring Trust to AR 
• Transferring Trust between Files 
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Trust > Looking up Trust > Using the Trust Index 
 

Using the Trust Index 
 

TheTrust Index window appears when you open the Trust module. It shows a list of your Trust 
transactions. 

1. To open the Trust Index, navigate to the Billing side of Amicus and then click the Trust 
button in the Navigation Pane. 
 

 
 

2. The screen shows information for each Trust transaction: the date, type of transaction, 
Client Matter ID, Primary Client Name, check/transfer To name or receipt From name, 
check/receipt number, description, Trust Bank Account number, and amount of 
receipt or check/transfer. At the bottom of the list, totals for the currency columns 
appear. 
 

3. You can scroll up and down in the list of transactions, and sort it by clicking the heading 
of the column you want it sorted by. 
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Transaction types 
The following types of transactions are listed: 

• Chk—Trust check 
• Rec—Trust receipt 
• TAR—Trust to AR transfer (done automatically at time of billing or via the Trust 

Transfer to AR function) 
• FFT—File to File transfer of Trust 

Showing particular sets of transactions 
You may have a large number of Trust transactions. Using options in the control panel, you can 
filter the list of transactions shown. 

• Account—By default, transactions for all Trust Bank Accounts are shown. Type or 
select a particular Account to limit the list to one Account. 
 

• Dated—By default, transactions for all dates are shown. To limit the list differently, 
select one of the other options and specify the desired date(s). 
 

• Include—Select which types of transactions to list. 
 
 Related Topics 

• Trust 
• Looking up Trust 
• Receiving Trust 
• Paying Expenses from Trust 
• Transferring Trust to AR 
• Transferring Trust between Files 
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Trust > Receiving Trust 
 

Receiving Trust 
 

Use theTrust Receipt function to receive Trust funds from a Client and record them into a Trust 
Bank Account for one or more of their Open, Billable Files. 

To transfer a Client's Trust funds within a Trust Bank Account from one File to another, use the 
File To File Transfer function instead—see Transferring Trust between Files. 

To open the Trust Receipt dialog: 

1. Click theTransactions button on the Amicus Toolbar in the Billing-side Files, Clients, 
Trust, or Billing modules and selectTrust > Trust Receipt. 
 
 Or, right-click on a Bill, File, or Client in a Billing-side list and choose Trust > Trust 
Receipt. 
 

 
2. The Trust Receipt screen appears. 
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3. Enter basic information for the receipt: 
• Receipt to—Trust Bank Account to which money is being deposited. 
• Receipt #—Optional identification number, automatically incremented. 
• Date—Date of the receipt. 
• From—The name of the person from whom payment is being received. 
• Amount—Dollar value of money being deposited. 
• Pmt. Type—Method of receipt (check, cash, credit card, electronic, or other). 
• Check #—Optional identification number such as a check number or credit card 

transaction number, which can be printed on reports or used for sorting. 
• Description—Description of the payment (default provided from Firm Settings). 

 
4. Examine and edit information in the list of Files as appropriate. 

 
5. The list shows information about each File, including the amount being added to Trust 

on the File, and new Trust balance on the File. 
 

6. Enter the transaction description and amount for each File. Add additional Files (for the 
same Client) to the allocation list if desired. You must allocate the total amount of the 
Receipt. 
 

7. Balances for the currently selected File in the list are shown at the bottom of the 
screen. 
 

8. Click Save & New or Save & Close to save the Receipt. 



Amicus Billing User Guide  146
   
 

Printing receipts 
The Administrator can set your firm to allow receipt printing. If so, to always print automatically 
or prompt first. Enter an email address in the E-mail Receipt to: field 
 

 

A receipt can be output in the following ways: 

• When you save a new payment to Trust. 
 

• When you run the Receipts report from the Reports module. (This allows you to reprint 
a receipt if necessary). 
 

• Receipts cannot be printed for Trust Receipts that record Startup Trust Balances. 
 

Related Topics 

• Trust 
• Looking up Trust 
• Using the Trust Index 
• Paying Expenses from Trust 
• Transferring Trust to AR 
• Transferring Trust between Files 
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Trust > Paying Expenses from Trust 
 

Paying Expenses from Trust (Trust Checks) 
 

Use theTrust Checkfunction to pay Expenses (disbursements) for one or more Clients from a Trust 
Bank Account. 

Applying Trust 
1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, 

Trust, or Billing modules and choose Trust > Trust Check. 
 

2. Or, right-click on a Bill, File, or Client in a Billing-side list and choose Trust > Trust Check. 
 

 
 

3. The Trust Check screen appears. 
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4. If your firm is not set up to receive APX payments,  Get Paid Faster - Accept Credit 
Cards displays beside the Method field. 
 

5. Clicking on this link  opens the APX Guide where you can read about all the advantages 
of becoming an APX enabled firm. 
 

6. Enter basic information for the check: 
 

• From—Trust Bank Account from which money is being withdrawn. 
• Check #—Optional identification number, automatically incremented. 
• Date—Date of the check. 
• To—The name of the person to whom payment is being made. 
• Amount—Dollar value of money being paid. 
• Type—Method of payment (check or other). 
• Description—Description of the payment. 

 
7. If Trust check printing is allowed at your firm (as set by your Amicus Administrator), 

and the payment Type is "Check", then a Print option is available at the right. Select 
that option to have a check printed when you Save the transaction. 
 

8. Examine and edit information in the list of Files as appropriate. 
 

https://amicusattorney.blob.core.windows.net/amicushelp/2000/AmicusGuides/APX.pdf
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9. The list shows information about each File, including the amount being paid on the File 
and new Trust balance on the File. 
 

10. Enter the transaction description and amount for each File. Add additional Files to the 
allocation list if desired. You must allocate the total amount of the Check. The 
descriptions will appear in the Trust Statement section of the next Bill on each File. 
 

11. Balances for the currently selected File in the list are shown at the bottom of the 
screen. 
 

12. Click Save & New orSave & Close to save the Payment. 

Printing checks 
The Amicus Administrator can set your firm to allow Trust check printing and if so, whether to 
print automatically or ask first. 

 

A check can be output in the following ways: 

• When you save a new Trust Check (if you've selected the Print option). 
• When you open an existing Trust Check and either clickPrint (if the check was not 

previously printed), or click Reprint (if allowed by your Administrator). 
• When you run the Checks report from theReportsmodule (including reprinting if 

allowed). 
 
 Related Topics 

• Trust 
• Looking up Trust 
• Receiving Trust 
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Trust > Transferring Trust to AR 
 

 Transferring Trust to AR 
 

Use the Trust to AR Transfer function to move money from a Trust Bank Account to a General 
Bank Account, in order to pay Bills, WIP Expenses, and/or unposted interest for one or more 
Clients and Files. Funds assigned to WIP Expenses or unposted Interest will be added to General 
Retainer in order that they be paid on the next Bill that includes them. 

• Any payment amount left unallocated to Bills (that is, any overpayment) will be 
received as new General Retainer. This amount is shown below the list of Bills. Click 
the Allocate To Files button to specify how this General Retainer is allocated across 
the Client's Files. 

Transferring Trust funds 
1. Click the Transactions button on the Amicus Toolbar in the BILLING-side Files, Clients, 

Trust, or Billing modules and chooseTrust > Trust Transfer to AR. 
 
 Or, right-click on a Bill, File, or Client in a Billing-side list and choose Trust > Trust 
Transfer to AR . 
 

 
2. The Trust Transfer to AR dialog box displays. 
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3. Enter basic information for the transfer: 
 

• From—Trust Bank Account from which money is being transferred. 
• Check #—Optional identification number, automatically incremented. 
• Date—Date of the check. 
• Transfer To—General Bank Account to which money is being transferred. 
• Receipt #—Optional identification number. 
• Type—Method of payment (check or other). 
• Description—Description of the transfer (default provided from Firm Settings). 

 
4. If Trust check printing is allowed at your firm (as set by your Amicus Administrator), 

and the payment Type is "Check", then a Print option is available at the right. Select 
that option to have a check printed when you Save the transaction. 
 

5. Examine and edit information in the list of Files as appropriate. 
 

6. The list shows information about each File, including the balances as of today (AR, WIP 
Expenses, and accrued unposted Interest if set for the firm and this File, and total), 
Trust balance available (as of the Transfer Date or today, whichever amount is less), 
and the amount being transferred. 
 

7. Enter the amount to transfer for each File. Add additional Files to the allocation list if 
desired. 
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8. Balances for the currently selected File in the list are shown at the bottom of the 
screen. 
 

9. To view or edit the transfer distribution for a File, click Details. The Trust to AR 
Distribution Details dialog appears. 
 

 
 

• Unpaid Bills on the File are listed, from oldest to newest. For each Bill the 
amount outstanding is shown and you can edit the amount you want applied. If 
there is accrued, unpaid interest on the Invoice (and unposted Interest if set for 
the firm and this File), the interest owing is shown and you can edit the amount 
you want applied. To transfer nothing for a Bill, simply clear the checkbox at the 
left. 
 

• If there are WIP Expenses on the File, you can enter below the list the amount 
you want transferred to General Retainer (in order to pay those Expenses when 
they appear on a Bill). 
 

10. When finished, click OK. 
 

11. Click Save & New or Save & Close to save the Payment. 
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Printing checks 
The Amicus Administrator can set your firm to allow Trust check printing and if so, whether to 
print automatically or ask first. 
 A check can be output in the following ways: 

• When you save a new Trust to AR Transfer. 
 

• When you open an existing Trust to AR Transfer and either click Print (if the check was 
not previously printed), or click Reprint (if allowed by your Administrator). 
 

• When you run the Checks report from theReportsmodule (including reprinting if 
allowed). 

 
 Related Topics 

• Trust 
• Looking up Trust 
• Receiving Trust 
• Paying Expenses from Trust 
• Transferring Trust between Files 
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Trust > Transferring Trust between Files 
 

Transferring Trust between Files 
 

Use the Trust File to File Transfer function to reallocate Trust balances from one File to another, 
within a Trust Bank Account. This is typically, but not necessarily, between Files for the same 
Primary Client. 

Transferring Trust funds 
1. Click theTransactions button on the Amicus Toolbar in the BILLING-side Files, Clients, 

or Trust modules and choose Trust > File to File Transfer. Or, right-click on a File or 
Client in a Billing-side list and chooseTrust > File to File Transfer. 
 

2. The Trust File to File Transfer screen appears. 
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3. Enter basic information for the transfer: 
 

• Bank Account—Trust Bank Account within which Trust is being transferred. 
• Date—Date of the transfer. 
• Transfer From—File from which Trust is being transferred. The amount available 

is shown at the right. 
• Description—Description of the transfer. 

 
4. Add one or more Files in the list below, and specify how much Trust should be 

transferred to each. The new Trust balance on each File is shown. 
 

5. Balances for the currently selected File in the list are shown at the bottom of the 
screen. 
 

6. Click Save & New or Save & Close to save the Transfer. 
 

Related Topics 

• Trust 
• Looking up Trust 
• Using the Trust Index 
• Receiving Trust 
• Paying Expenses from Trust 
• Transferring Trust to AR 
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Reports 
 

  Reports 
 

The Reports module provides access to: 

• Reports 
• Bill Templates 
• Reminder Statement Templates 
• E-mail Cover Sheet Templates 
• Also, access to Receipt Templates and Check Templates depending on your Firm Settings. 

 

Running Reports 
Billing Users can run all Reports, but only for those Files & Clients they have access to. Billing 
Supervisors can run all Reports for all Files and Clients. The Bill Summary report has been 
updated to include the APX payment option in thePayment amount field. 
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Running Templates 
Billing Users can run Templates to view the Bills, Reminder Statements, Receipts, and Checks 
they have access to. 

Editing Reports and Templates 
• The display name and description of Reports and Templates can be edited by Billing 

Users who have report-editing rights. Simply right-click on an item in the list and 
chooseProperties. 
 

 
• The contents of Reports and Templates can be edited by Billing Users who have 

report-editing rights and have Microsoft Report Builder installed at their 
workstation. 

For more information, see theUsing SQL Reporting Services with Amicus guide, available from the 
Amicus Help Center and the Amicus Attorney Technical Resource Guides/Updates section of our 
website. 

Related Topics 

• Referral Report 
• Time and Fee Journal Report 
• APX Disbursement Report 

 

https://amicusattorney.blob.core.windows.net/amicushelp/2000/AmicusGuides/SQLReporting.pdf
https://www.abacusnext.com/amicus-attorney-technical-resource-guides-updates
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Reports > Referral Report 
 

 Referral Report 
 

As referrals are the leading way to get clients, theReferral report is handy to track how clients 
are being referred. 

To access the Referralreport: 

1. Click on Firm Reports in the control panel on the ATTORNEY side and select 
BusinessPlanningfrom the navigation bar. 
 

 
 

2. Select Referral Report from the list that appears in the main screen. 
 

3. A Referral Report dialog displays. 
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4. Complete the following optional fields to filter the parameters of the report. 
 

• File Open Date– Enter dates in the From andTo fields. 
• File Type – Select a type from the pull-down menu. 
• Responsible Lawyer– Click on the person icon and select a person from the list. 
• Referral Source – Enter the source of your referral. 
• Include Closed Files – Check the appropriate radio button, defaults to No. 
• Summary Only – Click Yes to display the summary only with no details, defaults 

to No. 
 

5. A report displays with Posted, Billed and Paidfees. 
 

 
6. Billed and Paid fees are applicable for firms with BILLING activated. 
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Reports > Time and Fee Journal Report 

 

 Time and Fee Journal Report 
 

To view the reason for edits in the Time and Fee Journalreport: 

1. Click on Reports in the control panel and Reportsin the left navigation pane to display a 
list of reports for your firm, selectTime and Fee Journalfrom the list. 
 

 
 

2. The Generate - Time and Fee Journal dialog displays. 
 

3. Complete the necessary fields and select the Yes radio button in the Include 
Corrections field. 
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4. The tracking reason is appended to the notation when the Time and Fee Journalreport 
is generated. 
 

 
 

 

Related Topics 

• Reports 
• Referral Report 
• APX Disbursement Report 
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Reports >APX Disbursement Report 

 

 APX Disbursement Report 
 

The Disbursement Report allow firms to easily reconcile funds that were collected through APX 
and disbursed into their bank accounts. It comes directly from APX. Disbursements can include 
customer payments, or amounts refunded to a customer.  Nightly bank deposits can include 
funds from multiple transactions. 

To easily view funds that were collected through APX and disbursed to your bank accounts: 

1. Go to Firm Settings and click on APX under the Billing section to display the 
following dialog. 
 

 
 

2. Click APX Disbursement Report to display an APX Reports window. Use the 
controls at the top to minimize/maximize the window. 
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3. Click the down arrow in the Report Period to display your options. Either select one of 

the choices given or use the calendar controls to customize your Report Period. 
 

 
 

4. In our example, we selected to run the Disbursement Report from January 1st to 
June 7th, 2022, then clicked Apply to close the drop down menu, and clicked Run 
Report from the APX Reports window. 
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5. A progress bar displays while the report is running. 
 

 
 

6. After a few minutes the Disbursement Report displays with interactive fields. You can 
change the Report Period and/or enter Search criteria, then click Run Report to 
display another report. The No. of Disbursements, Total Amount Disbursed and 
Total Amount Refunded display clearly at the top of the report. 
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7. Click Expand All to expand all the items in the report, or select the arrow to the left of 
an item to expand it and see the transactions for that item. 
 

 
 

8. Click the arrow to the left of the item to compress it back to the original report. 
 

9. You can filter a Disbursement Report by entering a full or partial client name, matter 
or file name in the Search field provided and click Run Report. Only items that match 
your search criteria display. 
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Related Topics 

• Reports 
• Time and Fee Journal Report 
• Referral Report 
• How to set up APX 
• APX Defaults and Edits 
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Keyboard Shortcuts 
 

  Keyboard Shortcuts 
 

The keyboard shortcuts on the Billing side are similar to those on the Attorney side. The 
following tables specify the <CTRL> and Function key shortcuts available. 

• Universal shortcuts 
• Additional shortcuts within particular modules 

You can also navigate the menus and choose commands via the keyboard. To do this, hold down 
the <ALT> key while pressing the underlined letters in the menu and command names. For 
example, you could create a new Phone Message by pressing <ALT+F,N,M> instead of 
<CTRL+SHIFT+M>. The <ALT> shortcuts can be used only in those windows and dialogs that 
contain the corresponding menus. 

  



Amicus Billing User Guide  168
   
 

Keyboard Shortcuts > Universal shortcuts 
 

 Universal shortcuts 
 

The following shortcuts are available in all main module windows and, in many cases, the 
secondary windows and dialogs as well. 

General (Attorney & Billing sides) 

To switch sides... Press this... 

Switch to the Billing side (from the Attorney side) CTRL+SHIFT+Z 

Switch to the Attorney side (from the Billing side) CTRL+SHIFT+Z 

Creating items (Billing side) 

To switch sides... Press this... 

New item appropriate to the current module CTRL+N 

New Phone Call CTRL+SHIFT+P 

New Phone Message CTRL+SHIFT+M 

New E-mail CTRL+SHIFT+A 

New Time Entry CTRL+SHIFT+Y 

New Expense Entry CTRL+SHIFT+X 

New Timer CTRL+SHIFT+T 

New Event CTRL+SHIFT+E 

New Sticky Note CTRL+SHIFT+K 

New Contact CTRL+SHIFT+N 

New File CTRL+SHIFT+F 
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Opening modules (Billing side) 

To open... Press this... 

Office module CTRL+SHIFT+0 (zero) 

Files module CTRL+SHIFT+3 

Clients module CTRL+SHIFT+6 

Time, Fees, and Expenses module CTRL+SHIFT+7 

Trust module CTRL+SHIFT+1 

Billing module CTRL+SHIFT+2 

Reports module CTRL+SHIFT+4 

Online User Help F1 

Launching tools and editing text (Attorney & Billing sides) 

To do this... Press this... 

Accounting Exchange (if using QuickBooks Link) CTRL+SHIFT+C 

Search CTRL+SHIFT+S 

Print CTRL+P 

Select all CTRL+A 

Insert a Time Stamp in a text box CTRL+T 

Undo your edits in a text box CTRL+Z 

Clear the selected text DELETE 

Cut the selected text CTRL+X 

Copy the selected text CTRL+C 

Paste text into a text box CTRL+V 
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Keyboard Shortcuts > Additional shortcuts 
 

 Additional shortcuts within particular modules 
 

Files Index (Attorney & Billing sides) 

To do this ... Press this ... 

Copy the Address of the Primary Client on the Selected File(s) CTRL+R 

QuickFind (Files) CTRL+F 

New File CTRL+N 

Generate a Document CTRL+D 

File Details (Attorney & Billing sides) 

To do this ... Press this... 

Open Previous File CTRL+J 

Open Next File CTRL+K 

Copy the Address of the selected Person (or People) CTRL+R 

New File CTRL+N 

Generate a Document CTRL+D 

Client Index (Attorney & Billing sides) 

To do this ... Press this... 

Copy the Address of the selected Person (or People) CTRL+R 

QuickFind (People) CTRL+F 

New Contact CTRL+N 

Generate a Document CTRL+D 
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Client Details (Attorney & Billing sides) 

To do this.. Press this... 

Open Previous Person CTRL+J 

Open Next Person CTRL+K 

Copy the Address of the current Person CTRL+R 

New Client CTRL+N 

Generate a Document CTRL+ 

Time Module (Attorney & Billing sides) 

To do this ... Press this... 

QuickFind (Time Entries) CTRL+F 

New Time Entry CTRL+N 

Trust Module (Billing side) 

To do this ... Press this... 

New Trust Receipt CTRL+N 

Billing Module (Billing side) 

To do this ... Press this... 

New Bill CTRL+N 

 

Related Topics 

• Keyboard Shortcuts 
• Universal shortcuts 
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 Third-Party Links 

 

Third-Party Links 
 

Accounting: QuickBooks 
If your firm is licensed for Amicus Billing, Amicus enables you to share data dynamically with 
QuickBooks®. Amicus File and Client information is exchanged with QuickBooks Job and 
Customer information, and File/Job Types. 

You can take advantage of QuickBooks class lists, map Amicus Firm Members to QuickBooks 
Sales Reps based on Employees, map Amicus Expense Codes to QuickBooks Item Names, and 
have activities made available in QuickBooks. Billing Supervisors may import QuickBooks costs 
to Amicus as client Expenses. 

Client Bills are generated and paid within Amicus. Instead of exchanging Amicus Time Entries to 
QuickBooks, the Link sends Amicus General Ledger transactions (Receipts, General Retainer 
activity, Trust Receipts, Trust Checks, Trust to AR Transfers, and Trust File to File Transfers) to 
QuickBooks. During setup, billing-related posting options are provided and your Amicus 
Accounts must be mapped to QuickBooks Accounts. 

Firm Members can also view, edit, and exchange the QuickBooks Job Bill To Address details 
from the File that the Job is linked to. This address is kept synchronized between the programs. 

Amicus record type Exchange direction QuickBooks record type 

Files <----> Jobs 

Client Contacts <----> Customers 

Vendor Contacts <----- 
 (optional exchange) Vendors 

Billing Transactions -----> General Ledger Transactions 

Expenses (Hard Cost) <----- 
 (optional import) Client Costs 

 

For full details, including version requirements, see the QuickBooks Link Guide available from your 
Amicus Office Help Center orthe Amicus Attorney Technical Resource Guides/Updates. 

 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/AmicusGuides/QuickBooks.pdf
https://www.amicusattorney.com/technical-resource-guides/
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Billing 
 

Billing 
 

The Billing module, which is available only on the Billing side of Amicus, is where you coordinate 
activities that are related to your client matter bills, including bill payments, write ups/downs, 
and reminder statements. 

• Creating Bills 
• Posting Final Bills 
• Setting billing options 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Receiving Client Payments 
• Writing Bills up or down 
• Sending Reminder Statements 
• Reprint Bills 
• Exporting bills to a single PDF 

 
To refund General Retainer, see Refunding General Retainer. 
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Billing > Creating Bills 
 

Creating Bills 
 

The flexible billing function enables you to generate bills for individual client files or for multiple 
files for multiple clients. You can automatically post payments from trust and general retainer. 

Other options include the ability to save draft and final bills, as well as print a summary report of 
the drafts and final bills. You can also include non-billable no charge time on a bill. 

This topic includes: 

• Billing a single File 
 

• Billing multiple Files (mass billing) 
 

• Working with Draft Bills 
 

• Posting Final Bills 
 

• Setting Billing options 
 

• Allowing an APX payment during Billing 
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Billing > Creating Bills > Billing a single File 
 

Billing a single File 
 

Creating a Bill 
To create a Bill for a single File, go to the BILLING-side: 

1. Click Transactions on the taskbar in the Files, Clients, or Billing modules and choose 
Bill. Or, right-click on an item in a File or Client list and select Bill. 
 

2. If the File is a Contingency or Fixed Fee File, or is a Billable File with a Quoted Amount 
or Discount defined, a dialog appears, showing relevant information and allowing you 
to choose what amount to bill. For example, for a Quoted Amount File you can choose 
to increase/decrease the Fees amount to the quoted amount. 
 

3. Split Bill—If the File is set for Split Billing and is the Master File, separate Bills will be 
automatically created for it and each of its Sub Files, with its Fees/Expenses allocated 
between the Bills as pre-defined. Sub File Billswill additionally include any File-specific 
Fees/Expenses within the billing period. For more information, seeSplit Billing. 
 

4. The Create Bills dialog appears, open to the Bill Single File view. 
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5. Fill in basic details as appropriate: 
 

• Specify the AR Date of the Bill, which appears on the Bill and is used for aging 
and interest calculations (if any). Transactions later than this date will not be 
included on the Bill. 
 

• Choose whether to include allFile transactions up to a specified date, or include 
particular types of transactions (Time/Fees, Expenses, Payments/Receipts, and 
Trust) up to dates specified in the Bill Options view. To open that view, click 
Edit/View Dates or click Bill Options in the navigation list in the Control Panel. 
Unposted Time Entries are not included. 
 

• The Bill Template set for the File is used by default. Optionally, select a different 
Bill Template here. Templates can be created and edited from the Reports 
module. To see a sample printout for your selected Template, click Preview. 
 

• Optionally select or clear the Check for unposted time checkbox. If selected, the 
next time you identify a File you will be warned if there are any unposted Time 
Entries on it. (Unposted Time Entries are not included on Bills.) 
 

• Select the File if not already selected. Once selected, the Primary Client's name 
appears in the Client field, and the charges and transfer balances appear below. 
 

• The Previous Balance amount is the Net Bill amount from the previous Bill for the 
File, excluding any nonpostable interest charges. 
 

• The Previous Payments and Write Up/Down amount is the total applied to 
previous Bills for the File during the Bill transactions period chosen. This amount 
does not include the entry or application of General Retainer on the current Bill. 
 

• The current Fees amount includes fees from only Bill Time Entries for the Bill 
transactions period chosen. Any No Charge Time Entries are excluded from the 
fee calculation. However, "No Charge - Show On Bill" items, and optionally Non-
Billable "Bill" items, can be shown on Draft and Final Bills without a dollar value. 
 

• Taxes are calculated on current Fees (assuming that the File is set for taxation) 
and on current Expenses that are set for taxation. 
 

• Interest charges are calculated if the File is set for that. A Firm Setting determines 
whether or not these charges are posted to AR or merely shown as an item on 
Bills. 
 

• Optionally, adjust the amounts: Fees, Expenses, or Trust and/or General Retainer 
transfer amounts and Trust Bank Account. 
 

• Optionally, clear the Bill Memo option, or select it and enter or edit the text to be 
printed on Bills. 
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6. Click Send To Final if you are satisfied with the Bill and are about ready to post it. 
Otherwise, click Send To Draft to move the bill to Draft status for review and/or 
adjustment. 
 

7. From a Draft Bill, you can remove or edit Time and Expense Entries if necessary—see 
Working with Draft Bills. You can change the status of a Final Bill back to Draft if you 
need to make any changes. 

Adjusting the Fees amount 
Optionally, edit the Fees amount. When you Tab out of the field or click elsewhere, a Fee 
Adjustment dialog appears, asking how you would like this change shown on the Bill. The option 
set for the File is provided as the default. 
 

 

You may choose any of the following: 

• For a Fees increase or decrease, simply adjust the Fees amount. 
 

• For a Fees decrease, optionally show a Courtesy Discount item on the Bill and, if desired, 
edit the description to be shown. 
 

• For a Fees increase, optionally show an additional Fee entry on the Bill, and, if desired, 
edit the description to be shown. 
 

• The Taxes, Total New Charges, and Net Bill amounts are automatically recalculated as 
appropriate. Transfer amounts are recalculated for a Fees decrease, but not for a Fees 
increase. 
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Adjusting the Expenses amount 
Optionally, edit the Expenses amount. When you Tab out of the field or click elsewhere, an 
Expense Entry dialog appears. Enter the Expense information. When you click OK, that new 
Expense is added to the Bill. It will be saved to the File when the Bill is posted. 

The Taxes, Total New Charges, and Net Bill amounts are automatically recalculated as 
appropriate. Transfer amounts are recalculated for an Expenses decrease, but not for an 
Expenses increase. 

Adjusting the Transfer amounts or Bank Accounts 
Optionally, edit the amount of Trust to be applied to existing AR and to new charges (including 
interest). And you can also edit the amount of General Retainer to be applied to new charges 
(including interest). Amounts are applied in a standard sequence: General Retainer is applied 
first, and then Trust to new charges (if set in the File's Bill Settings). 
 
 You can also select the Trust Bank Account from which money will be transferred, and the 
"Receipt to" General Bank Account, to which that money will be transferred. 

 

Related Topics 

• Creating Bills 
•  

Billing multiple Files 

•  
Working with Draft Bills 

•  
Posting Final Bills 

•  
Setting Billing options 
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Billing > Creating Bills > Billing multiple Files 
 

Billing multiple Files (mass billing) 
 

 

Tip: Mass Billing is an intensive process. We recommend that other users not 
perform Billing transactions (including Time Entry posting) while the Bills are being 
created. 

 
 To create Bills for multiple Files (rather than one by one): 

1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, or Billing 
modules and choose Bill to display the Create Bills dialog. 
 

 

2. Select Mass Billfrom the navigation pane on the left. 
 
 Also, the Mass Bills view opens directly if you right-click on multiple Files in a Billing-side 
File list, or one or more clients in a Billing-side Client list, and choose Bill. 
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3. Fill in basic details as appropriate: 

◦ Specify the AR Date of the Bills, which appears on the Bills and is used for aging 
and interest calculations. Bills will not include transactions that are later than this 
date. 

◦ Choose whether to include all File transactions up to a specified date, or include 
particular types of transactions (Time/Fees, Expenses, Payments/Receipts, and 
Trust) up to dates specified in the Bill Options view. To open that view, click Bill 
Options in the navigation list in the Control Panel. 

◦ Select a single Bill Template to be used or choose to use the individual Templates 
assigned for each of the Files (in the Admin > Bill Settings view of File Details). 
Regardless of this setting, any Bills created for Primary Clients set for 
Consolidated Billing will be created using the Template assigned in the Balances 
view of their Person Details. 

◦ Templates can be created and edited from the Reports module. To see a sample 
printout for a single selected Template, click Preview. 

◦ Choose whether to create Bills for all Files, only the Files for selected Primary 
Client(s), or only the Files you select. 

◦ If you chose to create Bills for selected File(s) only, single Bills are created even 
for those Primary Clients who are set for Consolidated Billing (in the Balances 
view of their Person Details). The File's Exclude from Mass Billing setting (in the File 
Details > Admin > Bill Settings view) is ignored. 

◦ If you chose to create Bills for all Files or selected Client(s), you can optionally 
filter the Billable Files further by one or more of the following: 
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◾ Selected Responsible Lawyer(s) 

◾ Selected File Type(s) 

◾ Total new Charges (Fees plus Expense WIP), Fees only, or Expense WIP 
only greater than a specified amount 

◾ Overdue account balance greater than a specified amount 

◾ A Payment has been made between the previous Bill's AR date and the 
current AR date 

Bills will not be created for Files that are marked Exclude from Mass Billing. If a 
Primary Client is set for Consolidated Billing, all their Files that meet the 
selection criteria and are not marked Exclude will be included on a single Bill. 

◦ If desired, click Interest Settings to adjust how interest is applied to overdue 
accounts. The default settings are supplied from Firm Settings > Billing - Interest 
& Reminder Statements. 

◦ If desired, click Check for Unposted Time to run the Time and Fee Journal Report—it 
will list any Unposted Time Entries up to your selected end date on the Files that 
meet your selection criteria. (Unposted Time Entries are not included on Bills.) 

◦ Click Apply/Change Selection to apply your selection criteria and list all Files, 
showing which ones are included for Bill generation. The reasons why Files are 
excluded are shown. To exclude additional particular Files, clear the checkbox for 
each of those Files. 
 
Fixed Fee Files are included if they have an amount specified, even if they have no 
WIP or Time Entries. 
 
Contingency Files are included if they have both a Judgment/Settlement and 
Contingency Rate specified, even if they have no WIP or Time Entries. 

4. Click Send To Final to create the Bills and move them to Final status, ready for posting. 
Otherwise, click Send To Draft to create the Bills and move them to Draft status for 
review and/or adjustment first. 

 
 Related Topics: 

• Creating Bills 
• Billing a single File 
• Working with Draft Bills 
• Posting Final Bills 
• Setting Billing options 
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Billing > Creating Bills > Posting Final Bills 
 

Posting Final Bills 
 

The Final Bills view of the Create Bills dialog enables you to review and change some options for 
Bills before posting them. 

To view or edit the Final Bills: 

1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, or 
Billing modules and choose Bill to display the Create Bills dialog. 
 

 
2. Select Final Bills from the navigation pane on the left. 

 
3. Also, theFinal Bills view opens directly if you create a Bill on a single File and click Save 

To Final. 
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4. Choose to show all Final Bills you have permission to view, or only the ones you 
created. Optionally, choose to show only the Bills for specific Responsible Lawyers, File 
Types, Billing Categories, or Primary Clients. 
 

• View, mark, edit, and delete Final Bills as desired. 
 

• For a Consolidated Bill in the list, you can click the + button at the left to expand 
the display, showing a sublist of the individual Files that have been billed 
together on the same invoice for the client. 
 

• To mark a Bill for processing together with other marked Bills, select the 
checkbox at the left. For example, you can click Print & Post on the Amicus 
Toolbar to print and post all marked Bills. 
 

• If you wish to send one or more Final Bills back to Draft for further review or 
editing, mark them in the list and click Send To Draft. Alternatively, right-click a 
single Bill in the list and choose Send To Draft. 
 

5. Select the sequence in which Bills are printed: 
 

• By Responsible Lawyer (and then by Client Matter ID) 
• By Client Name: Last Name if an Individual or Company Name if a Company 

(and then by Client Matter ID) 
• By Client Matter ID 
• In the list sequence that Bills are currently sorted in the view. 

 

 

Note: If you choose to sort by Responsible Lawyer, the lawyer used for a 
Consolidated Bill is the one on the File that comes first if sorted by 
Client Matter ID. 
 

6. When Bills are posted, this sorting controls the sequence in which Invoice Numbers are 
assigned. 
 

7. When ready, you may: 
 

• Click Print Preview to see the way your marked Final Bills will print. 
• Highlight a Bill in the list, right-click, and choose Print. 
• Click Print Bill Summary for a summary report of your marked Final Bills. This 

report shows for each Bill: the Client Matter ID, Client Name, Short File Name, 
invoice number, Responsible Lawyer, balance forward, and new amounts (Fees, 
Expenses, taxes, interest, and total). 

• Select the General Bank Account to which Trust Transfers to AR (if any) will be 
posted. 

• Choose whether to print checks for Trust Transfers to AR (if any), if Trust check 
printing is enabled for your firm by the Administrator 

• Print and post Bills—see below. 
  



Amicus Billing User Guide  184
   
 

8. When finished, click Close or click a different view in the Navigation Pane of the Create 
Bills dialog. 

Printing and posting Bills 
1. Click Print & Post to both print and post your marked Final Bills. Or, right-click a Bill in 

the list and choose Print & Post. One or more options dialogs will appear. 
 

2. If you Print & Post a single Bill, and you have E-mail Integration enabled, you may 
optionally display the Bill on the screen, and/or print it, and/or send it as an e-mail 
attachment. 
 

 
 

3. If you Print & Post a single Bill and don't have E-mail integration enabled, or Print & Post 
multiple Bills together, an E-mail Bills dialog appears so that you can confirm which Bills 
you want e-mailed, and even edit the e-mail address(es) to be used. 
 

4. Bills on the Files marked for e-mailing (in their Bill Settings) are selected by default, but 
you may select other listed Bills as well. 
 

5. Multiple e-mail addresses for a Bill must be separated by a semicolon—the e-mail will 
be sent To the first address, and Cc the other addresses. 
 

6. Upon clicking proceed, you may optionally display the Bills on the screen, and/or print 
them. 
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7. When a Bill is posted, an Invoice Number is assigned and a Trust Transfer to AR (if 
appropriate) will occur. The Bill will vanish from the Final Bills list and appear in the 
Billing Index. 
 

8. If e-mailing multiple Bills, or a single Bill without E-mail Integration, note that the e-
mail(s) are either sent immediately or saved to Outlook's Drafts folder, depending on 
which option your Amicus Administrator chose in Firm Settings for this feature. The 
subject and body of those e-mails is also specified there. 
 

9. If the File is set for E-billing, an E-bill format version of its Bill is automatically created 
as well. 
 

 

Tip: Posting a large number of Bills together is an intensive process. We recommend 
that other users not perform Billing transactions (including Time Entry posting) while 
the Bills are being posted. 

 

Related Topics 

• Creating Bills 
• Billing a single File 
• Working with Draft Bills 
• Posting Final Bills 
• Setting Billing options 
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Billing > Creating Bills > Setting billing options 
 

Setting Billing options 
 

The Bill Options function lets you to customize Bill creation to suit the requirements of your 
firm. The settings affect only new Bills that are created afterward. Changing the settings has no 
effect on existing Draft and Final Bills. 

To view or edit the options: 

1. Click the Transactionsbutton on the Amicus Toolbar in the Billing-side Files, Clients, or 
Billing modules and choose Bill to display the Create Bills dialog. 
 

 
2. Select Bill Options from the navigation pane on the left. 
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3. View and set options as desired. 
 
o Include which types of File transactions—Choose which types of File 

transactions (Time/Fees, Expenses, Payments/Receipts, and Trust) to include on 
new Bills, and for each type specify the date up to which transactions will be 
included. The Payment/Receipts and Trust settings affect the previous balance, 
payments, and interest calculations on the Bill. 
 

o For Trust transactions, you may choose to include only new entries (checks, 
receipts, and File transfers). This ensures that transactions that have appeared on 
a Bill will not appear again on subsequent Bills for the File. 
 

o The transaction date can be overridden in the Bill Single File view, where you 
can choose to simply include all transactions up to a single date. Although you 
cannot change these options in Draft or Final Bills, you can, from the Draft Bills 
view, choose to exclude particular Fee or Expense items. 
 

o Bill Memo—You choose to can include a statement on Bills, and specify the text 
of that statement, such as "We are now accepting credit card payments. Contact 
John Schultz at 212 323-4321 Ext. 12 for more details." 
 

4. This option (including the text of the memo) can be overridden in the Bill Single File 
view. 
 

5. When finished, you can go to the Bill Single File or Mass Bill view to create Bills using 
these options. Or, click Set As Default to save these options for subsequent use by 
you and other users—otherwise, your changes will be discarded when you close the 
Create Bills dialog. 

 
 Related Topics 

• Creating Bills 
• Billing a single File 
• Billing multiple Files 
• Working with Draft Bills 
• Posting Final Bills 

  



Amicus Billing User Guide  188
   
 

Billing > Creating Bills > Working with Draft Bills 
 

Working with Draft Bills 
 

The Draft Bills view of the Create Bills dialog enables you to review and modify details of Bills that 
are in Draft status. 

Viewing or Editing the Draft Bills 
To view or edit the Draft Bills: 

1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, or 
Billing modules and choose Bill. Or, right-click on an item in a Billing-side File or Client list 
and choose Bill to display the Create Bills dialog. 
 

 

2. Select Draft Bills from the navigation pane on the left. 
 
Also, the Draft Bills view opens directly if you create a Bill on a single File and click Send 
To Draft. 
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3. Choose to show all Draft Bills you have permission to view ("All Bills"), or only the ones 
you created ("My Bills"). And optionally, choose to show only the Bills for specific 
Responsible Lawyers, File Types, Billing Categories, or Primary Clients. 

4. View, mark, edit, and delete Draft Bills as desired. 
 
For a Consolidated Bill in the list, you can click the + button at the left to expand the 
display, showing a sublist of the individual Files that have been billed together on the 
same invoice for the client. 
 
To mark a Bill for processing together with other marked Bills, select the checkbox at 
the left. For example, you can click Print Draft Bills on the Amicus Toolbar to print all 
marked Bills. 
 
The bottom part of the view shows details of the Bill currently highlighted in the list 
above. 

◦ The Bill Overview section at the bottom left shows the current Bill amounts: new 
Fees and Expenses, total new charges, etc. 

◦ The Bill details section at the bottom center and right provides separate views of 
the Bill's Fees, Expenses, transfers, and fee distribution. For more information, 
see below. 
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5. Select the sequence in which Bills are printed (and previewed): 

◦ By Responsible Lawyer (and then by Client Matter ID) 
◦ By Client Name: Last Name if an Individual or Company Name if a Company (and 

then by Client Matter ID) 
◦ By Client Matter ID 
◦ In the list sequence that Bills are currently sorted in the view 

Note that if you choose to sort by Responsible Lawyer, the lawyer used for a 
Consolidated Bill is the one on the File that comes first if sorted by Client Matter ID. 
 

6. When ready, you may: 

◦ Click Print Bill Summary for a summary report of your marked Draft Bills. This 
report shows for each Bill: the Client Matter ID, Client Name, Short File Name, 
invoice number, Responsible Lawyer, balance forward, and new amounts (Fees, 
Expenses, taxes, interest, and total). 

◦ Click Print Preview to see the way your marked Draft Bills will print. (The Invoices 
Number is not included.) 

◦ Click Print to print your marked Draft Bills for review and approval. 
◦ Click Send To Final to create Final Bills from your marked Draft Bills. Alternatively, 

right-click a Bill in the list and choose Send To Final. 
TIP: Sending a large number of Bills to Final Draft is an intensive process. We 
recommend that other users not perform Billing transactions (including Time 
Entry posting) while the Bills are being sent. 

7. When finished, click Close or click a different view in the Navigation Pane of the Create 
Bills dialog. 
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Bill details - Fees view 
The Fees view lists all Fees on the Bill, regardless of status. "No Charge" Fees, and optionally 
Non-Billable "Bill" Fees are shown (and identified in the Description). The list also includes any 
Courtesy Discounts (negative Fee Adjustments) done when the Bill was created. (Positive Fees 
Adjustments done simply appear as additional new Fees.) 
 

 

 

To open the Time Entry Details dialog for a Fee, for viewing, editing, or deleting, select it, right-
click, and choose Open. 

To delete a Time Entry and its Fee, select it, right-click, and choose Delete. 

To exclude a Time Entry and its Fee from the Bill (without deleting it), clear its checkbox. 
 
 If you wish to remove a Courtesy Discount Fee Adjustment from the Bill, delete the Bill and start 
over. 

Bill details - Expenses view 
1. The Expenses view lists all Expenses on the Bill. 

 

 
 

2. To open the Expense Entry Details dialog for an Expense, for viewing, editing, or 
deleting, select it, right-click, and choose Open. 
 

3. To delete an Expense, select it, right-click, and choose Delete. 
 

4. To simply remove an Expense from the Bill without deleting it, clear its checkbox. 
 

5. If you wish to remove an Expense Adjustment from the Bill, delete the Bill and start 
over. 
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Bill details - Transfers view 
1. The Transfers view shows Trust and/or General Retainer Transfer amounts and balances. 

 

 
 

2. You can edit the amount of Trust to be applied to new charges (including interest). And 
you can edit the amount of General Retainer to be applied to new charges (including 
interest). Amounts are applied in a standard sequence: General Retainer is applied first, 
and then Trust to new charges (if set in the File's Bill Settings). 
 

3. If the File has funds in more than one Trust Bank Account, you can select the one from 
which money will be transferred, and the "Receipt to" General Bank Account, to which 
that money will be transferred. 
 

4. When finished, click Apply. 

Bill details - Fee Distribution 
1. The File's Bill Settings show how Fees will be distributed among lawyers (Timekeepers) 

when Payments to the Bill are made by clients. 
 

2. The Fee Distribution includes those original Fees, and any adjustments that were done 
manually in Bill Single File or automatically from a Discount, Contingency Fee, or Flat 
Fee calculation. 
 

 



Amicus Billing User Guide  193
   
 

3. You can change the distribution of adjustment among lawyers, but cannot change the 
total adjustment (or Net Fees). Add lawyer allocations if desired. When finished, click 
Apply. Or, to undo your changes, click Reset. 

 

Related Topics 

• Creating Bills 
• Billing a single File 
• Billing multiple Files 
• Posting Final Bills 
• Setting Billing options 
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Billing > Looking up Bills, Write-Ups/Downs, and Payments 
 

 Looking up Bills, Write-Ups/Downs, and Payments 
 

On the Billing side, you can look up in various ways the posted Bills, the Write-Ups/Downs done 
on Bills after they are posted, and the Payments done against Bills: 

• In the Billing Index—see Using the Billing Index. 
• In the Transactions > All and Bills views of File Details—see Working with transactions 

on a File. 

To look up Draft and Final Bills rather than posted Bills, open the Create Bills dialog (e.g. by 
clicking Transactions > Bill on the Amicus Toolbar) and then navigate to the Draft Bills or Final 
Bills view as desired. See Creating Bills. 

Related Topics 

• Creating Bills 
• Receiving Client Payments 
• Writing Bills up or down 
• Sending Reminder Statements 
• Reprint Bills 
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Billing > Looking up Bills, Write-Ups/Downs, and Payments > Using the Billing Index 
 

Using the Billing Index 
 

The Billing Index window appears when you open the Billing module. It shows a list of your Bills. 

1. To open the Billing Index, navigate to the Billing side of Amicus and then click the 
Billing button in the Navigation Pane. 
 

 
 

2. The Billing list shows information for each Bill: the Client Matter ID, Primary Client 
Name, AR Date, Invoice Number, new charges (Fees, Expenses, Taxes, and total), 
amount paid, outstanding balance owed, and aging (for outstanding Bills, the number 
of days since the AR Date), and the Responsible Lawyer initials. At the bottom of the 
list, totals for the currency columns appear. 
 

3. Files billed together in a Consolidated Bill for a Client are shown as separate Bills in the 
list. These Bills have the same Invoice Number. 
 
o Reminder Statements for interest posted to Accounts Receivable are listed as 

"Bills". They have a different Invoice Number than the original Bill(s) on which 
the Interest is charged. 

o A File Summary for the currently highlighted Bill is shown at the bottom of the 
Billing Index window. 
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o You can scroll up and down in the list of Bills, and sort it by clicking the heading 
of the column you want it sorted by. 

Transactions list for a Bill 
Click the + icon for a Bill to expand the list, showing a sublist of the transactions on that Bill: 

• Original Bill (or Reminder Statement for Interest posted to Accounts Receivable) 
• Write-Ups and Write-Downs 
• Payments—Trust Transfers to AR Transfers done at the time of billing or later, 

General Retainers applied at the time of billing or later, and Receive Payments done 
after billing 

The transactions are shown in date sequence from oldest to newest. For each transaction, the 
list shows the date, Invoice Number or reference number, amount, and resulting outstanding 
balance. 
 

 

 

Showing particular sets of Bills 
You may have a large number of Bills. Using options in the control panel, you can filter the list of 
Bills shown. 

• Bills dated—By default, Bills for all AR dates are shown. To limit the list differently, 
select one of the other options and specify the desired date(s). 

• For which Files—By default, Bills on all Open Files are shown, including Files that are 
also Inactive. To limit the list differently, select one of the following options instead: 
◦ All—This shows Bills on any File regardless of File status. Bills on Files that are 

Closed or Inactive are shown. 
◦ Active—This shows only Bills on Active Files. Bills on any File that is Inactive or 

Closed are hidden. 
• For your Files or all Files—By default, only the Bills on Files to which you are assigned 

are shown (My Files option). However, depending on your assigned Security Profile 
or Firm Member Designations, you can select the Firm Files option to show Bills on 
all Files regardless of who is assigned to them, select the Firm Files option. 

• For whose Files—To show only the Bills on Files to which particular Firm Members are 
assigned, select the type of Firm Member ("Responsible Lawyers", "Introducing 
Lawyers", or any "Firm Members") and then click the People icon to select one or 
more particular people. 
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• Or, to show only the Bills on Files to which particular Primary Clients are assigned, 
select the type of Client ("Primary Clients") and click the People icon to select one or 
more particular Clients. To show only the Bills on Files to which a particular Client is 
assigned (regardless of whether or not they are the Primary Client on the File), select 
"Clients" and click the People icon to select a Client. 

• For what File Type—To show only Bills on Files of a particular File Type, such as 
"Corporate" or "Real Estate", select a type in the Type list box. Or, to include all Files 
regardless of File Type, select "All". 

• For what Special Status—To limit the list to Bills on Files assigned a specific Special 
Status, select that Special Status in the Special box. Or, select "No Selection" to 
include Files regardless of Special Status. 

• Paid/unpaid—To limit the list of Bills based on their current balance, select an option 
in the Show box at the bottom of the control panel: all Bills, only Bills with an 
outstanding balance, or only fully paid Bills. 

 

Related Topics 

• Looking up Bills, Write-Ups/Downs, and Payments 
• Working with Bills listed in the Billing Index 
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Billing > Looking up Bills, Write-Ups/Downs, and Payments > Working with the Billing Index 
 

 Working with Bills listed in the Billing Index 
 

You can select one or more Bills listed in theBilling Index, right-click, and choose to: 

• Receive Payment against the Bill (or multiple selected Bills if they have the same 
Primary Client) 
 

• Transfer Trust to AR in order to pay the Bills or cover WIP Expenses on the 
corresponding Files 
 

• Create a Reminder Statement for the balance owing on all Bills on the corresponding 
File 
 

• Write up/down the value of a Bill 
 

• Open the corresponding File Details (if a single Bill is selected) 
 

• Delete the Bill (if allowed) 
 

• Open the PDF or Word version of the Bill image for viewing or reprinting (a Word 
version can also be edited) 
 

• View the Bill history to generate the Invoice History Report 
 

Related Topics 

• Looking up Bills, Write-Ups/Downs, and Payments 
• Using the Billing Index 
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Billing > Receiving Client Payments 
 

Receiving Client Payments 
 

Use the Receive Payments function to receive a payment from a Client: 

• Payment of Bills whereby money is deposited into a General Bank Account 
 

• Payment of Bills via application of General Retainer amounts (money is deposited to a 
General Bank Account but not yet applied, so not yet withdrawn from that account) 
 

• Payment of General Retainer on Files (money is deposited into a General Bank 
Account) 
 

To receive money to Trust from a Client, use the Trust Receipt function instead—see Receiving 
Trust 

 

Note: 

 Trust and General Retainer can also be applied against new charges at the time 
of billing. 

Receiving payment 
1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, or Billing 

modules and choose Receive Payment to display the Receive Payment dialog. 
 
Or, right-click on a bill in the Billing Index, a file in the Billing-side Files Index, or a client in 
the Billing-side Clients Index and choose Receive Payment. You can also right-click on a bill 
in a Transactions view of File Details and choose Receive Payment. 
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2. Enter basic information for the receipt: 

◦ Receipt to—General Bank Account to which money is being deposited. This field 
is not used if you are only applying General Retainer. 

◦ Date—Date that money is being received. Bills up to this date will be listed. 
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◦ Receipt #(optional)—Number is automatically incremented (and overridable if 
permitted by your Firm Settings). 

◦ Show Bills Filtered By—Choose whether to list Bills for a Primary Client, a File, or 
an Invoice Number, and specify which one. If showing Bills for a particular Client 
or File, only outstanding Bills are listed. If showing Bills for a particular Invoice 
Number, you can choose include paid Bills. 

◦ Received from—The name of the person from whom payment is being received, 
which will appear on the printed receipt. The default is the name of the Primary 
Client on the File(s) for the Bills listed. You can type a name if desired. 

◦ Amount—Dollar value of money being deposited. If only applying General 
Retainer against Bills, enter zero. 

◦ Type—Method of payment (check, cash, credit card, electronic, or other). 
◦ Check #—Optional identification number such as a check number or credit card 

transaction number, which can be printed on reports or used for sorting. 
◦ Description—Description of the payment (default provided from Firm Settings). 
◦ Apply General Retainer Balances against Bills—Select this option to automatically 

apply General Retainer on Files against the corresponding Bills listed (shown in 
the Apply Rtnr. column). If multiple Bills are listed for a File, Retainer is applied in 
date order, starting with the oldest Bill. Clear this option if you want to clear the 
values in the Apply Rtnr. column. 

3. Examine and edit information in the list of Bills as appropriate. (Skip this step if you are 
only adding new General Retainer.) 
 
 The list shows information about each Bill: the Invoice Number, AR Date, Client Matter 
ID, billed total, current balance outstanding, amount being paid from the new amount 
submitted by the Client, current General Retainer balance on the corresponding File, 
and amount being paid from General Retainer. 
 
Allocating payment to Bills: 

◦ When the list is displayed, General Retainer balances are automatically allocated 
to the Bills first. (If there are multiple Bills on the same File, General Retainer is 
allocated to Bills in chronological order, starting with the oldest Bill.) Then the 
new payment amount is automatically allocated to the Bills, starting with the 
oldest Bill first. 

◦ If desired, edit the allocated amounts. Reducing the Payment amount on a Bill 
increases the Unallocated Payment amount below the list accordingly, and 
reducing the Apply Rtnr. amount increases the corresponding Rtnr. Avail. amount 
accordingly. Amounts are not automatically reallocated to the other Bills. 

◦ To skip payment of one or more of the listed Bills, clear the checkbox at the left 
on those lines. This clears the Payment and Apply Rtnr. amounts for those Bills. 
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Distributing payment within a Bill: 

◦ When finished allocating new payment and General Retainer on a Bill, you can 
click Details in the Distribution column to view or edit the distribution of that 
total payment within the Bill. The Payment Distribution dialog appears. 
 

 
The total payment is automatically allocated between Taxes, Expenses, 
Timekeeper Fees, and Interest, as determined by settings for the firm, File, and 
Bill. If desired, edit values in the Apply column to change the allocation, and click 
OK. 

4. Any payment amount left unallocated to Bills (that is, any overpayment) will be received 
as new General Retainer. This amount is shown below the list of Bills. Click the Allocate 
To Files button to specify how this General Retainer is allocated across the Client's Files. 
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 All Open Files for the Primary Client are listed. Edit the Retainer Allocation fields to 
distribute the full Retainer amount as desired and then click OK. 

5. Click Save & New or Save & Close to save the Payment. 

Printing receipts 
The Administrator can set your firm to allow receipt printing and if so, to prompt first or always 
print automatically. 
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A receipt can be output in the following ways: 

• When you save a new Payment. 
• When you run the Receipts report from the Reports module. (This allows you to 

reprint a receipt if necessary). 
The receipt shows only the cash receipt amount, omitting any General Retainer amount applied 
in the transaction. 

Receipts cannot be printed for Payments that record Startup General Retainer Balances. 

 

Related Topics 

• Creating Bills 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Writing Bills up or down 
• Sending Reminder Statements 
• Reprint Bills 
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Billing > Writing Bills up or down 
 

Writing Bills up or down 
 

Use the Write Up/Down function to write up or down the amounts on a posted Bill and/or change 
the Lawyer distribution of unpaid Fees on it. 

Adjusting Bills 
1. Click theTransactionsbutton on the Amicus Toolbar in the BILLING-side Files, Clients, or 

Billing modules and choose Write Up/Down to display the AR Write Up/Down dialog. 
 
Or, right-click on a bill in the Billing Index, a file in the BILLING-side Files Index, or a client in 
the BILLING-side Clients Index, and choose Write Up/Down. You can also right-click on a bill 
in a Transactions view of File Details and choose Write Up/Down. 
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2. Select a Bill to adjust. You may first select a File and then an Invoice Number (for one of 
the Bills on that File). Alternatively, you may skip the File selection and instead select an 
Invoice Number (from among all Bills, optionally including paid Bills). 
 
For the selected Bill, the amounts billed, paid, and outstanding are shown for Fees, 
Expenses, Taxes (if enabled for the firm), and Interest (if enabled for the firm). At the 
bottom of the screen, summary balances are shown for the File. 

3. Enter a transaction description. 

4. To adjust the outstanding amounts on the Bill, enter a change amount (positive or 
negative) or the new outstanding amount. 

5. To adjust the Fee distribution among lawyers, click Lawyer Distribution. 
 

 
 
 The total outstanding amounts are automatically allocated between the lawyers. If 
desired, edit values in the Change or New Unpaid Distribution column. Add additional 
lawyers if you like. When finished, click OK. 

6. Click Save to save the Write Up/Down. 

 

Related Topics 

• Creating Bills 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Receiving Client Payments 
• Sending Reminder Statements 
• Reprint Bills 
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Billing > Sending Reminder Statements 
 

Sending Reminder Statements 
 

Use the Reminder Statements function for creating Statements of Account for money owing, to 
send to Clients. 

If Interest is applicable and set for posting, it will be posted to Accounts Receivable when the 
Statement is generated. It will be assigned a different Invoice Number than the original Bill(s) on 
which the Interest is charged and will be listed as a "Bill" in the Billing Index. 

Creating Reminder Statements 
1. Click the Transactionsbutton on the Amicus Toolbar in the BILLING-side Files, Clients, or 

Billing modules and choose Reminder Statement. Or, right-click on an item in a BILLING-
side File or Client list and choose Reminder Statementto display the Reminder Statement 
dialog. 

2. Select Create from the left navigation pane. 
 

 

3. Fill in basic details as appropriate: 

◦ Specify the Aging Date—Bills with a newer AR date will be excluded. Payments and 
Write Ups/Downs up to this date will be included. If charging Interest, it will be 
calculated up to this date. 
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◦ Select a single Reminder Statement Template to be used, or choose to use the 
individual Templates assigned for each of the Files (in the Admin > Bill Settings 
view of File Details). 
 
 In general, any Bills for Interest will be created using the individual Templates 
assigned for each of the Files (in the Admin > Bill Settings view of File Details). 

◦ Templates can be created and edited from the Reports module. To see a sample 
printout for a single selected Template, click Preview. 

◦ Choose whether to create Statements for all Files, only the Files for selected 
Primary Client(s), or only the Files you select. 

◦ If you chose to create Statements for selected File(s), single Statements are created 
even for those Primary Clients who are set for Consolidated Billing (in the 
Balances view of their Person Details). The File's "Send Reminder Statements" 
setting (in the File Details > Admin > Bill Settings view) is ignored, as is the grace 
period and the minimum balance set for your firm by your Amicus Administrator. 

◦ If you chose to create Statements for all Files or selected Client(s), you can 
optionally filter the Files further by one or more of the following: 

◾ Selected Responsible Lawyer(s) 

◾ Selected File Type(s) 

◾ Selected Billing Categor(ies) 
In this case, Statements will be created only for Files that are marked "Send 
Reminder Statements" in their File Details > Admin > Bill Settings view, and 
generally only for Files that have a balance currently owing that is greater than 
the threshold amount, as set for your firm by your Amicus Administrator. 
Statements will generally be created only for Files that meet both of the 
following additional criteria: 

◾ Are overdue (beyond their grace period), as set for your firm by your 
Amicus Administrator 

◾ Have a balance currently owing that is greater than the threshold amount, 
as set for your firm by your Amicus Administrator 

However, if any of the filtered Files is for a Primary Client who is set for 
Consolidated Billing (in the Balances view of their Person Details), these 
additional criteria are ignored—that is, the Statement will include all of the 
Client's Files as filtered, regardless of their balance owing. 

◦ Interest settings are summarized. If desired, click Interest Settings to adjust how 
interest is applied to overdue accounts. The default settings are supplied from 
Firm Settings > Billing - Interest & Reminder Statements. If you edit these 
settings, those changes will apply to any new Statements you create before 
closing the Reminder Statements dialog. 

4. Click Send To Draft to move Statements to Draft status, ready for previewing and/or 
generating. 
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Generating Reminder Statements (and posting Interest) 
The Draft view of the Reminder Statements dialog enables you to review Statements and 
change an option before generating them. 

1. Click the Transactions button on the Amicus Toolbar in the Billing-side Files, Clients, or 
Billing modules and choose Reminder Statement. Or, right-click on an item in a Billing-
side File or Client list and choose Reminder Statement. 
 
 The Reminder Statement dialog appears. Go to the Draft view. 
 

 

2. Choose to show all Statements you have permission to view, or only the ones you 
created. 

3. Preview, mark, or delete Statements as desired. 

4. For a Consolidated Statement in the list, you can click the + button at the left to expand 
the display, showing a sublist of the individual Files included together on the same 
Statement for the client. 

5. To mark a Statement for processing together with other marked Statements, select the 
checkbox at the left. For example, you can click Generate Statements on the Amicus 
Toolbar to generate all marked Statements. 
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6. Select the sequence in which Statements are printed: 

◦ By Responsible Lawyer (and then by Client Matter ID) 
◦ By Client Matter ID 
◦ By File Type (and then by Client Matter ID) 
◦ In the list sequence that Statements are currently sorted in the view 

Note that if you choose to sort by Responsible Lawyer, the lawyer used for a 
Consolidated Statement is the one on the File that comes first if sorted by Client Matter 
ID. 
If Interest is posted when Statements are generated, then this sorting controls the 
sequence in which Invoice Numbers are assigned. 

7. Choose whether the Statement should list any fully paid Bills on the File(s) it covers. 
Otherwise, only the outstanding Bills are listed. 

8. When ready, you may: 

◦ Click Print Preview to see the way your marked Statements will print. Or, right-
click a Statement in the list and choose Print Preview. 

◦ Click Generate Statements to both print your marked Statements. Or, right-click a 
Statement in the list and choose Generate Statement. These Statements will 
vanish from the Draft list and appear in the Billing Index. 
If interest is applicable and set for posting (rather than merely appearing as a 
memo item), a "Bill" for the new interest will be posted when the Statement is 
generated. 

9. When finished, click Close or click a different view in the Navigation Pane of the Reminder 
Statements dialog. 

 
 Related Topics 

• Creating Bills 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Receiving Client Payments 
• Writing Bills up or down 
• Reprint Bills 
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Billing > Reprint Bills 
 

Reprint Bills 
 

You may need to reprint a bill(s) in Amicus Billing. 

 

Note: 

The default format for printed bills is set in Firm Settings (either PDF/Word). 

 

To reprint bills: 

1. Click the checkbox in the Client Matter column header to select all bills. 
 

 

2. Unselect the bills you do not want to reprint. 

3. Click the Print   icon  in the Taskbar to display the Output dialog. 
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4. Select the appropriate checkbox: 

◦ Screen – Displays the selected bills on the screen. 
◦ Printer – Sends the selected bills to the printer. 

◾ Quick Print  – Uses the default printer without prompting you to select a 
printer. 

5. Click OK. A progress bar displays while the bills are being printed. 

6. When the reprinting is complete a Reprint Bills window displays with the following 
information. 
 

 

◦ X of N bills reprinted. 
◦ A list of bills that Amicus Billing was unable to print. 
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7. Click the Print  icon  for a report of the Reprint Bills. 
 

 

 
 Related Topics 

• Creating Bills 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Receiving Client Payments 
• Writing Bills up or down 
• Sending Reminder Statements 
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Billing > Exporting bills to a single PDF 
 

Exporting Bills to a single PDF 
 

Saving multiple bills to a single PDF file helps ensure that your bills are easy to find and paid on 
time. 

 

Related Topics 

• Billing 
• Creating Bills 
• Looking up Bills, Write-Ups/Downs, and Payments 
• Receiving Client Payments 
• Writing Bills up or down 
• Sending Reminder Statements 
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APX (Abacus Payment Exchange) > APX Recurring Payments 

 

APX (Abacus Payment Exchange) 
 

Abacus Payment Exchange (APX) is a payment solution that uses a single platform to process 
Credit Card and ACH payments within Amicus Billing so you get paid quickly. It also makes 
payments easy for your clients! 

Your Administrator is able to sign-up for APX within Amicus Attorney and pricing is simple. With 
APX, there are no hidden fees or long-term contracts. Only a 3% flat fee is charged for credit 
card transactions and $1 for ACH or E-check transactions. 

APX accepts most payment options including Mastercard, Visa, American Express, Discover, and 
ACH. This allows you to collect payments to your operating and trust accounts. 

The APX Authentication token is updated when a task that triggers a call to APX is made, such 
as adding a payment method, or making a payment. It is updated from the background of Amicus 
and is not visible to the user. 

Your Administrator signs up from within Amicus Attorney by going to Administration > Firm 
Settings and selecting Abacus Payment Exchange (APX) to display the Billing – Abacus Payment 
Exchange (APX) dialog. 

To start using APX a firm must complete the onboarding process and be approved by our 
partners. Only after successfully completing the underwriting can a firm start to handle credit 
card and ACH payments. See How to set up APX. 

 

Note: Abacus Payment Exchange (APX) is only available at this time to firms located in 
the United States and works only with bank accounts based in the United States. 

 

Related Topics 

• How to set up APX 
• APX Test Transaction 
• APX Defaults and Edits 
• Managing Payment Methods in Amicus Attorney 
• Making a Payment in Amicus Attorney 
• APX Payment Method List 
• APX Recurring Payments 
• APX Disbursement Report 
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APX (Abacus Payment Exchange) > Accept Credit Cards 
 

Accept Credit Cards 
 

Your Firm Administrator must set up APX (Abacus Payment Exchange) in order for your 
clients to use it. When your clients use APX it means you will get paid as quickly as your 
bank allows. 

If your Firm Administrator has not already set up APX for your firm, a Get Paid Faster -Accept 
Credit Cardslink displays in the Receipt Payment and Trust Receiptdialogs making it even easier 
to sign up for APX. 

1. On the BILLING-side Home page click on Receive Payment or Trust Transfer to 
AR under the Navigator section to display the corresponding dialog. 
 

 
 

2. These dialogs can also be accessed from the Clients module by selecting a client and 
right-clicking to display a pop up menu. Select either the Trust > Trust Receipt or 
Receive Paymentoption. 
 

3. If a firm is not already APX Enabled (approved) a linkGet Paid Faster - Accept Credit Cards 
displays in the corresponding dialog. 
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4. If you are not the Administrator for your firm, the link opens the APX Guide where you 
can read about all the advantages of becoming an APX enabled firm. 

 

Related Topics: 

• APX (Abacus Payment Exchange) 
• How to set up APX 
• Managing Payment Methods in Amicus Attorney 

 

  

https://amicusattorney.blob.core.windows.net/amicushelp/2000/AmicusGuides/APX.pdf
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APX (Abacus Payment Exchange) > How to set up APX 
 

How to set up APX 
 

To begin the Onboarding process: 

1. Go to the Firm Settings window. 
 

 
 

2. Click Abacus Payment Exchange (APX) under the Billing heading to display the Billing - 
Abacus Data Exchange (APX) screen. 
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3. Click the Learn More / Enroll button to display the first screen of the Onboarding wizard. 
 

 
4. Click LEARN MORE ABOUT APX or the video Start Button  to watch a short 

video about the APX integrated payment processing system. 
5. Click SIGN UP FOR FREE to begin the Onboarding wizard. The first step, About the 

Business section displays. Some of the fields are populated with information retrieved 
from the client contact card. Scroll down and click in the fields to edit or enter new 
information. 



Amicus Billing User Guide  221
   
 

 

 
• Click the Help   icon to display information about the field. 

• Click the down  arrow to select an option from the drop-down menu that 
displays. 

• Fields with an asterick * are Required. 
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6. Click Go to step 2 to move to the About the Owner section in the wizard. 
 

 
• Click in the fields to enter or edit new information about Owner 1. 
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7. Click ADD ADDITIONAL OWNER to add multiple owners and complete the fields. 
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8. Click Go to step 3 to display the Add Bank Account section. 
 

 

• Click the  icon under the Plaid fields to Add accounts via Plaid for the 
Operating and Trust Accounts. 

• Or, click the   icon under the Manually fields to Add accounts manually for 
these accounts.  

 

Plaid is a technology platform that allows you to securely 
connect to your financial institution in seconds. 
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9. If you use Plaid to link to your bank the following screen displays. 
 

 
• Click Continue to add a bank account. 

10. A prompt displays informing you that a Bank accounthas been successfully added! 
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11. Click OK. The bank account is added to the appropriate field under Plaid. 
 

 
12. If you choose to add your bank account Manually, the following dialog displays. 

 

 
13. Complete the fields, drag and drop or browse to add Supporting Documents in the last 

field. 
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14. Click Add Operating Account when you are finished. The account displays under the 

Manually field. 
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15. Click Go to step 4 to display the Terms and Conditions section. 
 

 
16. Click the Bank Disclosures link to display the following screen. 
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17. Click the Merchant Terms and Conditions link to display the following screen. 
 

 
18. Return to the Terms and Conditions screen and click the I Agree checkboxes to 

acknowledge that you have read, understood, and agree to the terms outlined in the 
screens. 
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19. Click Submit to complete your APX Application. 
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20. Click Book a training session or return to the Firm Settings screen. 
 

 
• You will receive Email Notification Approval. This may take up to 2 business days. 

Related Topics 

•  
APX (Abacus Payment Exchange) 

•  
APX Test Transaction 

•  
APX Defaults and Edits 

•  
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Managing Payment Methods in Amicus Attorney 
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APX (Abacus Payment Exchange) > APX Test Transaction 
 

APX Test Transaction 
 

When you onboard to APX a Congratulatory message displays notifying you that your APX 
account is active. 

1. Click Get $5 Gift to get started testing the APX workflow. 
 

 
 

2. An APX intake form displays. Ensure that the details are correct and add email(s) in the 
We will send a transacation details to this email(s) field if you wish. 
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3. Click Get $5 Gift to complete the transaction. 
 

Related Topics 

• APX (Abacus Payment Exchange) 
• How to set up APX 
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APX (Abacus Payment Exchange) > APX Defaults and Edits 
 

APX Defaults and Edits 
 

When APX is NOT enabled for the General Bank Account: 

1. Right-click on a file in the File Index or select Create Bill under BILLING on the Billing 
Home Page to display the Create Bills dialog: 
 

• The APX – Credit Card / ACH option is hidden. 
 

2. Click Send to Draft to create a draft bill. 
 

• Filter the bills from the pull-down menu in the Use bills with field. 
 
 When APX is enabled with not file selected. 

1. Select Create Bill under BILLING on the Billing Home Page to display the Create Bills 
dialog: 
 

• The APX – Credit Card / ACH option displays. 
 

2. Click Send to Draft to create a draft bill. 
 

• Filter the bills from the pull-down menu in the Use bills with field. 
 
 When APX is enabled with the file selected. 

1. Right-click on a file in the File Index or select Create Bill under BILLING on the Billing 
Home Page to display the Create Bills dialog: 
 

• Any change to the default payment method will reset the APX amount to zero. 
• By default funds are utilized for transfer and payment in the following order: 

1. General Retainer 
2. Trust Retainer 
3. Credit Card/ACH 

• The Transfers amount on the left equals General Retainer + Trust + APX 
transfers and changes dynamically when changes are made to these amounts. 

2. The following message displays when the transfer is greater than current charges: "You 
cannot enter a negative amount for any of the transfer/payment amounts." 

3. Select the Transfers/Payments tab to edit all the transfers. 
 

Related Topics 

• APX (Abacus Payment Exchange) 
• How to set up APX  
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APX (Abacus Payment Exchange) > Managing Payments in Amicus Attorney 
 

Managing Payment Methods in Amicus Attorney 
 

To open the APX Payment Methods screen: 

1. Click Office > People in the left navigation pane to display your contacts. 
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2. Click a contact from the People Index. In our example we will click Janet Bailey to 
display her Contact Card. 
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3. Click Actions > Manage APX Payment Methods from the top Navigation bar. 
 

 
4. A screen listing APX Payment Methods for the contact displays. 
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Adding an APX Payment 
To add an APX payment, click OK to return to the client card or Add if you wish to add another 
APX Payment method. 

• The Payment Method dialog displays with information retrieved from the client card. 
 

Adding a Credit Card 

1. Click the Credit Card radio button on the right side to enter Credit Card Information. 
 

 
 

2. Some of the fields are populated with information retrieved from the client card. Click into the 
fields to edit or enter new information. 
 



Amicus Billing User Guide  240
   
 

 
 

3. Click Save to save the New Payment Method. You are returned to the APX Payment 
Methods screen where you can continue to add APX Payment Methods. 
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Adding an E-Check / ACH Payment Method 

1. Click the eCheck / ACH radio button, then click in the fileds to edit or enter new 
information. 
 

 
 

2. Click Submit to return to the APX Payment Method screen where the new information 
has been added. 
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10. Click Add in the footer to continue to add APX Payment Methods or select an APX 
payment and click Delete to delete an APX Payment Method. 

11. ClickOK to return to the client card. 

Editing an Existing APX Payment 
APX Payments are not editable. It is recommended that you Delete an existing Payment Method 
and Add a new APX Payment if you need to change a billing address or email details. 

 

Related Topics 

• APX (Abacus Payment Exchange) 
• How to set up APX 
• APX Defaults and Edits 
• Making a Payment in Amicus Attorney 
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APX (Abacus Payment Exchange) > Making a Payment in Amicus Attorney 
 

Making a Payment in Amicus Attorney 
 

To make a payment in Amicus Attorney you must have access to the BILLING-side of Amicus 
Attorney. 

1.  Click the BILLING tab at the top of the left Control Panel on the Home window to display 
the Billing Home screen. 

 

2. Click the Files module in the left Control Panel of the Navigator window to display the Files 
Index. 
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3. Click the Transaction button at the top of the screen and select Receive Payment to display 
the Receive Payment dialog. 
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◦ Select a payment Method from one of the following options in the pull-down 

menu: 

◾ Credit Card Payment (APX) 
◾ ACH Payment (APX) 
◾ Check 
◾ Cash 
◾ Credit Card 
◾ Electronic 
◾ Other 

◦ Enter the charge in the Amount field. 
If your firm is not set up to receive APX payments,  Get Paid Faster - Accept Credit 

Cards displays beside the Method field. 
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◦ Clicking on this link  opens the APX Guide where you can read about all the 
advantages of becoming an APX enabled firm. 

4.  Complete all other fields by entering information or selecting from the pull-down menus. 
Some of the fields may be populated with information retrieved from the client card. 
Click Pay Now to display the following prompt: 
 

 

5. Click Yes if you would like to proceed with the transaction. A Payment Processed prompt 
displays with a Confirmation #. 

https://amicusattorney.blob.core.windows.net/amicushelp/2000/AmicusGuides/APX.pdf
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◦ Click Copy to copy the content to the clipboard or click OK to return to the 

Receive Payment dialog box. 
◦ If the credit card process was unsuccessful a prompt displays notifying you of the 

reason. If the problem continues, please contact technical support for assistance 
with the Transaction ID. Click OK. 

◾ An expired card cannot be processed 
6. If Print client receipts for banks acounts is set, a Print Receipt prompt displays. Click OK to 

print the receipt. 

7. Click Cancel to return to the Files Index. 
 

Related Topics 

• APX (Abacus Payment Exchange) 
• Allowing an APX payment 
• Viewing APX Transactions 
• Voiding and Refunding an APX transaction 
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APX (Abacus Payment Exchange) > Allowing an APX payment during Billing 
 

Allowing an APX payment during Billing 
 

You can apply an APX - Credit Card / ACH payment while you are creating a bill allowing for 
greater efficiciency. APX payments are allowed on single, consolidated and split billing. 

1.  Click on the Transferstab on the Create Bills dialog to include an APX - Credit Card / ACH 
payment. Below is an example of a Consolidated bill with an APX payment applied. 
 

 

2. In the APX - Credit Card / ACHsection you can add an APX payment or select from the 
pull-down menu if the APX payment is already on file. 

 

Related Topics 

• APX (Abacus Payment Exchange) 
• Making a Payment in Amicus Attorney 
• Viewing APX Transactions 
• Voiding and Refunding an APX transaction 
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APX (Abacus Payment Exchange) > Viewing APX Transactions 
 

Viewing APX Transactions 
 

APX payments are prefixed with (APX). When a transaction does not have a description 
associated with it the Transaction Type is prefixed with (APX). 

Payments are handled in the same manner for both APX payments: 

• Credit Card Payments (APX) 
• ACH Payments (APX) 

The Billing View Files Details 
To access the Receipt Payment dialog: 

1. Select Receipt Payment form the Navigator section of the BILLING-side Home screen: 
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Or, open a file and go to the Taskbar,  click on the Transactions icon  and select Receive 
Payment from the pull-down list. 
 

 

2. The Receive Payment dialog displays: 
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Trust Bank – Trust Receipt (UI View) 
To view the Trust Receipt dialog box: 

1. Open the File Details window and select File Facts > All Transactions or Trust from the left 
sidebar navigation bar. 
 

 

◦ A description is always displayed 
2. Click on the Transactions icon in the Taskbar and select Trust > Trust Receipt from the pull-

down list. 
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3. The Trust Receipt dialog displays: 
 

 

Printed Receipt and Bills (New Payment) 
To print receipts for bank accounts: 

1. Select Office > Firm Settings from the left navigation pane to display the Firm Settings window. 
 

 

2. Scroll down to the Billing section and select Bank Accounts to display the Billing - Bank 
Accounts dialog. 
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3. Select the Print client receipts for bank accounts checkbox. 
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Reports 
To generate an APX - Credit Card and ACH Report: 

1. Select Office > Firm Settings from the left navigation pane to display the Firm Settings window. 
 

 

2. Scroll down to the Billing section and select Abacus Payment Exchange (APX) to display the 
Billing - Abacus Payment Exchange (APX) dialog. 
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3. Click APX Transaction Report to display the APX - Credit Card and ACHReport dialog. 
 

 

3. Complete the following fields by entering information or selecting from the pull-down 
menus: 

◦ From and To dates 
4. Click OK to generate the report. 
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Related Topics 

• APX (Abacus Payment Exchange) 
• Making a Payment in Amicus Attorney 
• Voiding and Refunding an APX transaction 
• Reversing an APX payment 
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APX (Abacus Payment Exchange) > Voiding and Refunding an APX transaction 
 

Voiding and Refunding an APX transaction 
 

APX allows clients to quickly handle Credit card and ACH receipts for both the general and trust 
bank. If you change your mind or made a mistake on a transaction you can cancel a payment or 
ask for a refund. 

APX payments cannot be deleted since they represent real money. All APX payments have an 
option in the footer to Void/Refund the transaction. 

The difference between voiding and refunding is as follows: 

• Refunding a transaction returns money back to the customer’s credit card. 
• Voiding a transaction cancels the original transaction as if it never happened. 

Both transactions may take up to 5 days to process. 

Voids are the first choice as they are more cost effective than refunds. However; they only work 
on unsettled transactions. As a general rule, our partners at Vantage recommend that Firm 
Members confirm they have received the deposit into their bank account before issuing any 
refunds. 

An APX transaction can be voided on the same day as long as it hasn't been settled. The 
settlement time is 9 pm UTC, the time standard around the world. This is 3 pm Mountain Time 
or 5 pm Eastern Time. Transactions created after the 9 pm settlement time remain voidable until 
the next day's 9 pm settlement. 

Voiding/Refunding APX Payments 
To void/refund an APX payment: 

1. Open an APX Receive Payment dialog box: 
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2. Click Void/Refund in the footer to begin the process. 
 

• A request is sent to our partners at Vantage after validating a transaction can 
bevoid/refund. Vantage responds by letting us know if the transaction can be 
voided. 
 

3. One of the following prompts displays. 
• If a Credit Card transaction can be voided this is the first choice. 
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4. Click Yes to void/refund the transaction. 
 

• A message prompt displays informing you that " A payment may take up to 1 or 
more business days to be deposited into your bank account. The deposit cannot be 
verified at this time. Are you sure you wish to void/refund this ACH transaction?" 
 

5. Click Yes to display a prompt with a Confirmation # informing you that your payment 
has now been voided/refunded. 
 

 
 

6. Click OK to return to the Receive Payment dialog box. 
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• The Confirmation # is now red. 
o The text Voided with the date when the transaction was voided appear 

underneath 
 

• Click View Voided Entry to view the voided transaction. 
 

7. Double-click on a Client Matter ID in the Files module to display the File Details window. 
 

8. The voided/refunded transaction displays with a strikethrough in the Amount column. 
 

 
 

  

 

Notes: 

• ACH transactions may take up to 5 days to process 
• When an APX transaction cannot be voided a refund will be issued 
• A void/refund cannot result in a negative general retainer balance 
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Printing a Void/Refund Payment 
Double click on a void/refund payment and select Print from the footer of a Receive Payment or 
Trust Receipt to view a printed copy with a water mark with Void for the void transaction and 
Refund for a refund transaction . 

Reports 
Voided and refunded transactions are included on Cash Receipts and Trust Bank Journal reports 
along with the original transaction. 

 

Related Topics 

• APX (Abacus Payment Exchange) 
• Viewing APX 
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APX (Abacus Payment Exchange) > Reversing an APX transaction 
 

Reversing an APX transaction 
 

When an APX Payment fails the system determines if the payment method is VOID, or a 
REFUND should be issued, or if the payment method needs to be REVERSED. 

For example, if a REFUND or VOID is rejected by APX due to incomplete processing of the 
payment, the option  REVERSED is given. 

A payment reversal is when a transaction paid to you is returned to the buyer. This typically 
happens after a chargeback or having lost a dispute with a customer. 

In this situation, it is common to want to reverse the actions that a transaction triggered when it 
was originally received. 

 

Related Topics 

• APX (Abacus Payment Exchange) 
• Voiding and Refunding an APX transaction 
• Managing a Pay Now Request 
• APX Payment Method List 
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APX (Abacus Payment Exchange)  > Managing a Pay Now Request 
 

Managing a Pay Now Request 
 

Firm members can now easily include a Pay Now link with emailed invoices that allows the client 
to easily pay their bill by credit card. 

Pay Now emails include an embedded URL that clients can click and easily make an APX 
payment. They are generated from the Finalize Bill screen during the Create Bill process or from 
the Billing module after the bill is created. 

 

Important: To send a Pay Now request from the Billing module, the firm must 
have APX enabled on the general bank account. 

 

This topic covers: 

• To send an email with a Pay Now request 
• To create a Pay Now request when creating bill(s) 
• To create a Pay Now request from the Billing module 
• To resend a Pay Now request 
• To delete a Pay Now request 
• Receiving a payment from a Pay Now request 
• Viewing a payment from a Pay Now request 

To send an email with a Pay Now request 
1. Go to Firm Settings and select Emailing Bills under the Billing section to display the 

Billing - Emailing Bills dialog. 
 

2. Click on the APX PayNow Format tab. 
 

3. Select one of the following radio buttons from the Cover Email field. 
 
o Use Template 
o Use HTML Format 
o Use Simple Format 

  



Amicus Billing User Guide  264
   
 

4. Click on the dropdown arrow in the Select Template field to select a template. 
 

 
 

 

Note: Check that the template defined in the Firm Settings for APX PayNow 
Format has the URL variable included. If the URL is missing and you continue the 
client receives a standard e-mail without the Pay Now request. 
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To create a Pay Now request when creating bill(s) 
1. Use your current billing workflow to send the bills to "Final" in your billing cycle. 

 
2. On the create bill screen, select the bills you would like to finalize. 

 
3. Click on Print & Postto finalize your bills. 

 
• You will be prompted with a list of the finalized bills with options to send email 

and to include a payment request. 
 

4. Click on checkbox with thePay Nowrequest icon for the bills you would like to send an 
email with the payment request (embedded URL). 
 

5. Click on Proceed to continue. 
 

• Emails are sent to the draft folder or directly to the client based on the email 
selection in theFirm Settings. 
 

 

Note: Use the bill settings "Include APX Request for Payment with email" to 
automatically include a payment request when creating and emailing bills. 

To create a Pay Now request from the Billing module  
1. Select the Billing module from the left navigation pane in the BILLING view. 

2. Use the filters on the left to get a list of invoices you would like to send a Pay Now 
request email. 

3. Select one outstanding invoice (one without a payment) or click on the checkbox to 
select multiple invoices. 

4. Select the add    Pay Now icon payment request icon that becomes available to 
generate the Pay Now request email for each selected outstanding invoice with an URL 
embedded in the email. 

4. Emails are sent to the draft folder or directly to the client based on the email selection in 
the Firm Settings. 

 

Note:  

Pay Now request uses the email address defined on the file/matter Bill settings if 
this was setup, otherwise it uses the primary email address from the primary 
client on the file/matter. 
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To resend a Pay Now request  
1. Select the Billing module from the left navigation pane in the BILLING view. 

 
2. Use the filters on the left to get a list of invoices with a Pay Now request. 

 
3. Select an invoice or invoices (use the checkbox to select multiple invoices) with a Pay 

Now request. 
 

4. Select Action > Resend Payment Request to recreate and resend the email(s) with the 
existing URL(s). 
 

5. Emails are sent to the draft folder or directly to the client based on the email selection 
in the Firm Settings. 
 

A Confirmation message displays. Click Yes to confirm resending the Pay Now request or No to 
return to the Billing module without sending the Pay Now request. 

To delete a Pay Now request 
1. Select an invoice or invoices (use the checkbox to select multiple invoices) with a Pay 

Now request, the  Delete iconbecomes available. 

2. Select the  Delete iconto delete thePay Nowrequest(s). 

3. Click Yes on the Confirmation message to delete the select payment request. 

Receiving a payment from a Pay Now request 
When a Pay Now request payment is successfully completed by your client using the embedded 
link from the email, the payment is automatically sent to your client file in Amicus and a 
notification email of the payment is sent to the responsible lawyer on the file. 

Viewing a payment from a Pay Now request 
1. Open the client's file. 

 
2. Click on Bills in the BILLING view. 

 
3. Click the '+' sign on the bill where the payment was applied to list the payment record. 

 

 

Note: The Pay Now link on the email is active for 90 days. After 90 days the link 
becomes invalid and the client will be directed to contact the firm for assistance. 
At this time, you will be able to create a new Pay Now request from the Billing 
module. 
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APX (Abacus Payment Exchange)  > How to pay a Pay Now Request 
 

Paying a Pay Now Request 
 

Adding a new APX Payment Method 
When a user opens a link to make a payment from a Pay Now Request the following window 
displays. The user selects the appropriate radio button under the  Payment Method section or 
clicks the + plus icon to add a new APX Payment Method. 
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Removing an APX Payment Method 
1. Occasionally it is a good idea to clean up the Payment Method list to remove payment 

methods that are no longer being used by your firm. 

2. The Delete icon to the right of a payment method is enabled when a payment method 
isn't being used. Simply click on it to remove the payment method. This removes the 
payment method from the list and stops futre auto payments associated with that 
method. 

Paying a Pay Now Request 
An email is sent to the user with the Invoice attached. 
 

 

 
The following window displays when the PAY Now button is clicked from the body of the email. 

The user selects the appropriate radio button under the Payment Method section or clicks the + 
plus icon to add a new APX Payment Method. 
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3. After the Payment Method is selected the user clicksPAY NOW. 
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4. After the payment is processed a Payment Successful  window displays. 
 

 

5. A link to DOWNLOAD the receipt displays at the bottom of the Payment Successful 
window. 

6. APX also sends an email notification to the client. 
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APX (Abacus Payment Exchange)  > Payment Method List 
 

APX Payment Method List 
 

The APX Payment Method List allows for the selection of multiple clients. 

Select the checkbox Include expired Payment Method, if you want to include both expired and 
non-expired payment method(s) with your report. The default is to have this option unchecked. 

When the APX Payment Method List is generated: 

• All payment methods for selected client(s) are included in the list. 
• When no specific client is selected, the report is run for all clients. 
• The default payment method is indicated in the Type column. 

The APX Payment Method List report contains the Firm Name, as of today's date, the list of payment 
methods grouped by clients. 
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APX (Abacus Payment Exchange) > Expanded Client Portal Payment Options for APX 

 

Expanded Client Portal Payment Options for APX 
 

Invoices can be shared with all clients  using the Client Portal, not just the Primary Client making 
it easier for you to get paid. 

It is not necessary for the primary client to pay invoices. Expanded Portal Payment Options for 
APX allow for All portal users to add their own credit card or ACH information and pay via the 
portal. 

To make invoices visible to all clients on a file: 

1. Click the Visible to clients on the file who have portal access checkbox in the Portal 
Sharing window. 
 

 
 

2. Click OK. 
 

In the Client Portal the primary client, as well as non-primary clients can use the Payment 
Method associated with the login user or add a Payment Method to process a payment. 

See Paying a Pay Now Request. 

 

Note: The Payment Method is not saved when added by a non-primary client. 
However; the Portal Activity log and report is updated with the activity of the 
non-primary client. 
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APX (Abacus Payment Exchange) > APX Recurring Payments 

 

APX Recurring Payments 
 

APX Recurring Payments allow you to schedule future payments from your clients using credit 
card or ACH predefined intervals. 

The following APX Recurring Payment Schedules can be defined: 
 

Payment Schedule type Number of occurrences Date/Day (for 1st payment) 

Single* 1 Specified date 

Weekly n Day of week 

Bi-Weekly n Day of week 

Monthly n Day of month 

Semi-monthly n 1st and 15th or 15th and 
EOM 

Quarterly n Day and month selection 

 

* Use the Single payment schedule for postdated credit card or ACH payment. 

APX Recurring Payment schedules are associated with open billable file/matter. Amicus allows 
you to create, delete, and cancel an APX Recurring Payment schedule for both the General Bank 
Account and Trust Bank Account. 

The APX Recurring Payment schedules process APX payments based on the defined recurring 
period. The schedules are set up by your Firm Administrator and are available only after APX has 
been configured for your firm. See Setting up APX. 

Multiple payment schedules can be created for the same file. 

Requirements 
• Firms must have the BILLING-side enabled. 
• Firms must be APX enabled. 
• Billing Supervisors will have full access to APX Recurring Payments. 
• Billing User access will be based on the user's access to Receive Payment and Trust 

Receipt. 
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This feature can be accessed from: 

1. The Action menu of the File Details, Billing and Trust modules. 
2. Or, the Recurring Payment Schedule Icon on File Details, and Billing and Trust 

modules. 

Creating a New Payment Schedule 
To create a New Payment Schedule: 

1. Select Recurring Payments > Create Recurring Payments from the Action menu 
 

 
 
 Or, click on the Recurring Payment Icon on the File Details or Billing Module or Trust 
Module and select Create Recurring Payments. 
 

 
 

2. The Create Recurring Payment window displays. 
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3. Click the File icon to display the Select File window. Select a file and click OK. The file 
name displays in the File field. 
 

 
 

4. Click Next to display the New Recurring Payment Schedule. 
 

 
    

5. Complete the following fields: 
    
o The Payment Method field is populated if the primary client on the selected file 

has a default payment method. Keep the default or select an alternate from the 
dropdown menu if the primary client has multiple payment methods. 
   

o Select either Operating (General) or Trust from the dopdown menu in the Deposit 
to field. 
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o Select a Recurring Type from the dropdown menu. 
 

 
o Enter an amount in the Total Amount field or the Recurring Amount field. APX will 

calculate the amount for the other field. 
   

o Select a date from the calendar controls in the Start Date. 
   

o Select the End Date from the calendar controls or a value in the 
Occurrences field. APX will calculate the value for the other field. 
   

o Enter a description of the New Payment schedule in the Description field. 
   

o The Entered By field is populated with the name of the firm member creating the 
New Recurring Payment Schedule. 
   

o The Email notice to internal users is populated with the email of the firm 
member creating the New Recurring Payment Schedule. You can also enter up to 
10 email addresses, separated by commas. 
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6. Click Create Schedule. The Recurring Payments window displays with the newly created 
payment schedule. 
 

 
    

7. Click the X at the top right of the Recurring Payments window to return to the Billing 
module. 

  

 

Notes: 

• APX payments are processed on the Recurring Payment schedule 
dates. 
   

• An email notification is sent to the firm member's email address listed 
on the Recurring Payment schedule. 
   

• Recurring payments are automatically updated to the file/matter 
associated with the Recurring Payment schedule. 
   

• For Recurring Payments to the General Bank Account, payments are 
first applied to any outstanding invoices at the time of the payment, 
and any remaining payments are allocated to the General Retainer. 
   

• For Recurring Payments to the Trust Account, a trust receipt is 
recorded on the file/matter associated with the Recurring Payment 
schedule. 
   

• The entry start date for a semi-monthly Recurring Payment should be 
the day before the first occurrence payment date. 

 

  



Amicus Billing User Guide  278
   
 

Editing an APX Recurring Payment 
You can open an APX Recurring Payment schedule dialog and change the description, payment 
method and email address. 

To edit a Recurring Payment Schedule: 

1. Select Recurring Payments > View Recurring Payments from the Action menu 
 

 
 
Or, click on the Recurring Payment Icon on the File Details, Billing Module or Trust 
Module and select View Recurring Payments. 
 

 
 

2. The Recurring Payment window displays. 
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Note: When selecting Recurring Payment from the File Details, the existing 
Recurring Paymentschedule associated with the current file displays. However; 
selecting Recurring Payment from the Billing and Trust modules will list Recurring 
Payment schedules for all files. 

 

3. Select a recurring payment from the list and click Open to view the Recurring Payment 
Schedule. 
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4. Click in the Payment Method field and select another option from the drop down menu 
to change the payment method. You may also click in the Description field and enter a 
new description or click in the Email notice to internal users to enter a new email. The 
other fields are non-editable. 
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Payment Overview 
1. Click Payment Overview to view your Recurring Payments for the selected file. 

 

 
    

2. Click Close to return to the Recurring Payment window 

Cancelling an APX Recurring Payment Schedule 
You can cancel an APX Recurring Payment schedule up until the day before the process date. 

1. Select Recurring Payments > View Recurring Payments from the Action menu 
 

 
 
Or, click on the Recurring Payment Icon on the File Details or Billing Module or Trust 
Module and select View Recurring Payments. 
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2. The Recurring Payment window displays. Select an Active Recurring Payment and click 
Open to display the Recurring Payment Schedule. 
 

3. Click Cancel from the taskbar to display a Cancel Payment Schedule prompt. 
 

 
 

4. Click Close to return to the Recurring Payments window or Confirm to cancel the 
payment schedule. 
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Note: The payment schedule is permanently canceled. To resume a payment 
schedule you must Create a New Payment Schedule 

Deleting an APX Recurring Payment 

 

Note: An APX Recurring Payment schedule can only be deleted prior to the selected 
Start Date or if there are currently no successful payments on the schedule. 

 
To delete a Recurring Payment Schedule: 

1. Select Recurring Payments > View Recurring Payments from the Action menu. 
 

 
 
Or, click on the Recurring Payment Icon on the File Details or Billing Module or Trust 
Module and select View Recurring Payments. 
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2. The Recurring Payment window displays. 
 

 
 

3. Select the Recurring Payment schedule you wish to delete and click Delete in the 
taskbar. A prompt displays asking if you are sure you want to delete the payment 
schedule. 
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4. Click Close to cancel the deletion and return to the Recurring Payments window or 
Confirm to delete the payment schedule. 
 

 
 
o The APX Recurring Payment schedule is deleted from the list of current Recurring 

Payments. 
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Viewing an APX Recurring Payment 

Payments from a Recurring Payment Schedule are posted to the associated files/matters as an 
APX payment. 

Recurring payments posted to the General Bank Account are recorded as Receive Payment (if the 
payment was applied to invoice(s)) or as a General Retainer if it was not applied to an invoice. 

Recurring payments posted to the Trust Bank Account are recorded as Trust Receipts. 
 
Double-click the transaction to open it and view the Recurring Payment.  
 

 
 
The APX payment transaction is displayed with the confirmation number of the APX payment. 
 

 
Note: This Recurring Payment is an APX transaction and can be Voided or Refunded. 
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Email Notifications after receipt of payment 
An email notification is sent to the customer's email that contains receipt of payment. 

 
An email is also sent to the firm member after the final payment of Recurring Credit Card 
Payments is received. 
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Related Topics 

• How to set up APX 
• APX Defaults and Edits 
• Managing Payment Methods in Amicus Attorney 
• Making a Payment in Amicus Attorney 
• Allowing an APX payment 
• Trust 
• Billing 
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APX (Abacus Payment Exchange) > APX Portal to track payments 

 

APX Portal to track payments 
 

A new APX Portal is created as part of the Onboarding process. 
       
 APX 2.0 includes access to the new APX Portal where firms can get an even greater insight into 
their payment processing. New reports, charts and graphs allow you to track payments and 
monitor trends from an elegant dashboard with options to drill down for more details. 
 

 
      
You will receive a link to the Account Portal in an email to get you started using the new APX 
Portal. 

Afterwards, you can log into the Account Portal and drill down to see information about your 
payment processing, as well as any chargebacks. 

Related Topics 

• How to set up APX 
• Managing Payment Methods in Amicus Attorney 
• Making a Payment in Amicus Attorney 
• Allowing an APX payment 
• APX Recurring Payments 
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Getting Around in Amicus Attorney 
 

In Amicus Billing, navigating to your records, accessing commands, working with lists, and so on 
are mostly the same. If you are a Billing User, the Navigation Pane has extra buttons for switching 
between the Attorney side and the Billing side, and a Navigator screen is provided in the Billing-
side Office module. 
  

Related Topics 

• Billing Users and Billing Supervisors 
• Amicus Navigation Pane 
• The modules 
• Amicus Floating Toolbar 
• Navigator 
• Getting help 
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Clients > Working with a Client's details 
 

Working with a Client's details 
 

As on theAttorney side, you can work with details on a Client from their Client Detailswindow. 
Double-click the Contact you want in the Contacts Index. Or, in an Attorney-side Person Details 
window, click Basicson the left-side navigation bar. 

 

As on the Attorney side, basic information for a Contact may be added and edited in the Basics 
view of the Contacts Details dialog: name, addresses, phone numbers, and so on. You can 
quickly add information about the Contact from the QuickEdit section in the control panel. You 
can use the Client's Business Card, work with their picture, and use their Last Contacted date. 

On the Billing side, the Client ID is shown at the upper right. 

In any view of the Client Detailswindow, you can choose commands on theFilemenu to perform 
a variety of tasks, such as creating a new Person record or printing the current view. 
 

Related Topics 

• Working with the File referrals list for a Person 
• Working with balances and billing options for a Client 
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Clients > Working with a Client's details > Working with the File referrals list for a Person 
 

Working with the File referrals list for a Person 
 

A list of the Files that a Person has referred to the firm is available from the Contact Details 
window on the ATTORNEY or BILLING side. 

Click Referrals on the left-side navigation bar. 

 

If you are a Billing Supervisor, the list shows the total fees billed on each File. This provides, at a 
glance, the value of all referrals from this person. 

Related Topics 

• Working with a Client's details 
• Working with balances and billing options for a Client 
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Clients > Working with a Client's details > Working with balances and billing options 
 

Working with balances and billing options 
 

To view summary balances for a Client or work with their billing options, open the Billing-side 
Client Details window and choose Balances on the left-side navigation bar. 

The upper section of the Balances view shows combined balances for all Files on which the 
Client is the Primary Client and you have access to. 

If you want a brief comparison of balances for the individual Files on which they are the Primary 
Client (or have a Client-classified Role), instead expand the Client's row in the Client Index—see 
Using the Clients Index. 

 

Account Overview 

The table shows current balances for the File(s): 
• Unposted—unposted hours and Fees (excluding any Non-Billable or No Charge Time). 
• Posted—posted, unbilled hours, Fees, and Expenses. The hours and fees include only 

"Bill" items, and excludes any Non-Billable or No Charge items. Items on a Draft or 
Final Bill are included. 
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• WIP (Work In Progress)—unbilled hours, Fees, and Expenses. The hours and fees 
include only "Bill" items, and excludes any Non-Billable or No Charge items. Items on a 
Draft or Final Bill are included. 

• Billed—billed hours, Fees, Expenses, Taxes, and Interest. Posted Interest is included, 
memo interest is not. Fees, Expenses, and Taxes reflect any adjustments made at the 
time of billing or later via Write Ups/Downs. Only items on posted Bills are included. 

• Write Up/Down—Write Up/Down amounts for Fees, Expenses, Taxes, and Interest. 
• Paid—paid Fees, Expenses, Taxes, and Interest. 
• Accounts Receivable—AR balances (billed but not-yet-paid) for Fees, Expenses, Taxes, 

and Interest. 
 
 Below the table are shown additional balances and dates for the File: 

• Trust balance 
• General Retainer balance 
• When any of the Files was last billed (AR date of the last Bill) 
• When a Payment against a Bill was last received on the File (excluding receipt of 

General Retainer or Trust) 

Drilling down to detail information 
If an account overview value appears underlined when you move the cursor over it, you can drill 
down to related details. For example, click the WIP Fees amount to display the Time Index filtered 
to show unbilled Time Entries for this Client. Or click theLast Billed date to display the Billing 
Index filtered to show Bills for this Client. 

Client billing options 
The following billing options can be set in the bottom section of the Balances view: 

• Bill Profile—Choose whether to assign a default Bill Profile to all new Files on which 
this Client is the Primary Client, and select the particular Profile in the pull-down list. 
For more information, see Filling in billing settings for a File. 
 

• Consolidated Billing—Choose whether, when Mass Billing, to consolidate Bills for all Files 
(on which this Client is the Primary Client) onto a single Bill (with a single Invoice 
Number). This also determines, when mass creating Reminder Statements, a single 
Statement for all applicable Files for this client will be created. 
 
• If consolidating Bills and Reminder Statementsfor this Client, select the Bill Template 

to be used. 
• Templates can be created and edited from the Reportsmodule. To see a sample 

printout for your selected Template, click Preview. 

Related Topics 

• Working with a Client's details 
• Working with the File referrals list 
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